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Glossary
A list of words or terms specialized in this document.
Glossary Definition
BSP Board Support Package, the layer of software containing hardware-specific drivers and libraries to function in a
particular hardware environment.
CPU Central Processing Unit.
csv Comma Separated Values file.
DRC Design Rule Check.
DUT Design Under Test.
ESI Previous name of Propel.
FPGA Field Programmable Gate Array.
GUI Graphic User Interface.
HDL Hardware Description Language.
HSM Hardware Security Module.
IDE Integrated Development Environment.
IP-XACT An XML format that defines and describes electronic components and their designs.
LHS Left Hand Side.
LSB Least Significant Bit.
MSB Most Significant Bit.

Perspective

A group of views and editors in the Workbench window.

PGE

Package Generate Engine

A tool can program Lattice FPGA SRAM and external SPI Flash through various interfaces, such as JTAG, SPI, and

Programmer c.

RHS Right Hand Side.

RISC.V A free and open instruction set architecture (ISA) enabling a new era of processor innovation through open
standard collaboration.

SBX The files that store the spatial index of the features

SDK Embedded System Design and Develop Kit. A set of software development tools that allows the creation of
applications for software package on the Lattice embedded platform.

SoC System on Chip. An integrated circuit that integrates all components of a computer or other electronic systems.

SRAM Static Random Access Memory.

TCL Tool Command Language.

UFM User Flash Memory.

VIP Verification IP.

Workspace The (.:Iirectory whgre stores your work, it is used as the default content area for your projects as well as for
holding any required metadata.

Workbench Refers to the desktop development environment in Eclipse IDE platform.

www.latticesemi.com/legal



http://www.latticesemi.com/legal

mLATTICE

1. Introduction

Lattice Propel™ 2022.1 Builder is a graphical tool used to assemble complex System-on-Chip (SoC) modules which can
be used in the supported Lattice FPGA devices. These modules and/or IP can be assembled and connected easily by
simply dragging and dropping the modules and/or IP into the Schematic Window.

1.1. Purpose

Embedded system solutions play an important role in FPGA system design allowing you to develop the software for a
processor in an FPGA device. It provides flexibility for you to control various peripherals from a system bus.

To develop an embedded system on an FPGA, you need to design the System on Chip (SoC) with an embedded
processor. Lattice Propel Builder helps you develop your system with a RISC-V processor, peripheral IP, and a set of
tools by a simple drag-and-drop.

The purpose of this document is to introduce Lattice Propel 2022.1 Builder tool and design flow to help you quickly get
started to build a small demo system. You can also find the recommended flows of using Lattice Propel Builder in this
document.

1.2. Audience

The intended audience for this document includes embedded system designers and embedded software developers
using Lattice MachX03D, MachXO3L, MachXO3LF, MachX02, LIFCL, LFD2NX, LFMNX, LFCPNX, LFMXO5, and LAV-AT
devices. The technical guidelines assume readers have expertise in the embedded system area and FPGA technologies.
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2. Lattice Propel Builder Design Flows

The Propel Builder design flow includes creating a SoC project design flow, and verification design flow, which are
discussed in detail in the following sections.

2.1. Builder Environment

After Propel 2022.1 is installed, you can launch the stand-alone Propel Builder by double-clicking the Builder icon to
launch Builder. Refer to the Lattice Propel 2022.1 Installation for Windows User Guide (FPGA-AN-02056) for details on
the installation. After the Propel Builder is launched, a single workbench window is displayed. The workbench contains
Menu, Toolbar, Design View, IP catalog, Schematic view, address mapping, Start Page, and TCL console. Figure 2.1
shows the workbench with opening a project.

1. Menu bar

2. Toolbar

3. IP Catalog and Design View

4. Schematic View, Address Mapping, and Start Page
5. TCL Console

Hle Edt View Design Jools Window Help

T aQaQa ﬂ

kg o Schematic Address . Start Page

Ponlocl 1P on Server =
I Module/IP on Local
~ Module

b [ Architecture Modules

b [ Arithmetic Modules

+ 1 Memory_Modules

b [ Processors_Controllers_and_Peripherals ysment_inst

b 5 Verification P -
- P s s

gpioh_inst

b

S R G

w [ Processors_Contrallers_and_Peripherals
© o 160 1
© mscyme 220 77
© vart 130 6

a0 st ot

| i
.

| w0t

4 P50+

| | st
I

f= wef Fo
il equation split concat
invert 3 4

1P Catalk Design View
lcl Console O

% sbp_design open -name HelloWorld -path {C:/lscc/workspace/HelloWorld/HelloWorld/HelloWorld. sbx}
B

Figure 2.1. Propel Builder Workbench Window
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2.2. Project Design Flow

2.2.1. Creating a New SoC Project

1. Choose File > New Design from the Lattice Propel Builder Menu bar. The Create System Design — Design
Information wizard opens (Figure 2.2).
., Create System Design *
Design Information
Enter a name for your design and specify a directory where the design files will be stored.
Project:
Type: 50C Project i
Mame: EmptyProject
Location: = C:jlzcciworkspace| * | Browse...
Create Project at C: flscc/workspace EmptyProject
Mext = Cancel
Figure 2.2. Create System Design — Design Information Wizard
2. The default Project Type is displayed in the Type field.
e  You can select SoC Project from the drop-down menu, if you need to create a SoC project.
e You can select SoC Verification from the drop-down menu, if you need to create a verification project. Refer to
the Verification Project Design Flow section for more details.
Enter the desired project name in the Name filed.
(Optional) The default location is shown in the Location field. Use the Browse... option to change the project
workspace location.
5. Click Next. The Create System Design - Configure Propel Project wizard opens (Figure 2.3).
© 2022 Lattice Semiconductor Corp. All Lattice trademarks, registered trademarks, patents, and disclaimers are as listed at www.latticesemi.com/legal
All other brand or product names are trademarks or registered trademarks of their respective holders. The specifications and information herein are subject to change without notice
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. Create System Design

Configure Propel Project

Specify a device or board for project.

Language:

Verilog

Family: Board

LFCPNY {CertusPro-Mx) -
Device;

LFCPMX-100 4
Package:

ASG256 4
Speed:

7_High-Performance_1.0V -
Operating Condition:

Commercial <

Template Info:

Processor;
RISC-V MC

Templates:

Empty Project
Hello World Project

Empty project for user to "build from scratch™,

Device Information:

Part Number: LFCPMX-100-7ASG256C
Logic Cells: 96000
LUTs: 79872
Registers: 79872
EER Blocks: 208
LRAM: 7
DSP (18x18 Multiplier): 156
ADC Blocks: 1
PLLs: =+
DLLs: 2
PCSs: 2
AlUs: 1
DPHYs: 0
PIO Cells: 299
PIO Pins: 193
< Back Mext = Cancel

Figure 2.3. Create System Design — Configure Propel Project Wizard

6. (Optional) The default Verilog is displayed in the Language field. Use the drop-down menu to change the default

language.

7. Specify a device or a board.

e To specify a device for your new SoC project, use the drop-down menu to select desired device information

(Family, Device, Package and Speed), and select Empty Project in the Templates field (Figure 2.4).

© 2022 Lattice Semiconductor Corp. All Lattice trademarks, registered trademarks, patents, and disclaimers are as listed at www.latticesemi.com/legal.
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Configure Propel Project

Specify a device or board for project.

4 Create System Design *
Configure Propel Project
Specify a device or board for project.
Language: Device Information:
: Part Number: LFCPMX-100-7ASG256C
Verilog
Logic Cells: 96000
Family: Board Processor: LUTs: 79872
LFCPNYX (CertusPro-hx) = | RISCWYMC Registers: 79872
EBR Blocks: 208
Device: Templates:
: LRAM: 7
LFCPNX-100 = [NIERENED et DSP (1818 Multiplier): 156
Hello World Project
Package: ADC Blocks: 1
ASGI56 - PLLs: =+
DLLs: 2
Speed: PCSs: 2
7_High-Performance_1.0V - ALUs: i
Operating Condition: DPHYs: 0
= PIO Cells: 299
Commercia PIO Pins: 193
Template Info:
Empty project for user to "build from scratch™,
< Back Mext = Cancel
Figure 2.4. Specify a Device for a New SoC Project
Or, to specify a board for a new SoC project, check the Board option (Figure 2.6).
%, Create System Design X

Language: Device Information:
: Part Number: LFCPMX-100-7ASG256C
Verilog
Logic Cells: 96000
Family: Goard Processor: LUTs: 79372
LFCPNYX (CertusPro-hx) = | RISCWYMC Registers: 79872
EBR Blocks: 208
Device: Templates:
: LRAM: 7
LFCPNX-100 = [NIERENED et DSP (1818 Multiplier): 156
Hello World Project
Package: ADC Blocks: 1
ASGI56 - PLLs: =+
DLLs: 2
Speed: PCSs: 2
7_High-Performance_1.0V - ALUs: i
Operating Condition: DPHYs: 0
: PIO Cells: 299
C i 4
ommerca PIO Pins: 193
Template Info:
Empty project for user to "build from scratch™,
< Back Mext = Cancel

Figure 2.5. Specify a Board for a New SoC Project

14
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e The Configure Propel Project wizard is shown (Figure 2.7). From the Board Select area, select the desired
board, such as CertusPro-NX Evaluation.

%, Create System Design X
Configure Propel Project
Specify a device or board for project.
Language: Device Information:
- Part Number: LFCPMNX-100-8LFG672C
Verilog -
Logic Cells: 96000
Board Select: u Board Processor: LUTs: 79372
B RISC-V MC - Reaqisters: 79872
CrossLink-MNX Evaluation S EBR Blocks: 208
Lattice Sentry Demo Board for Mach-NX (256) R : LRAM: 7
Lattice Sentry Demo Board for Mach-NX (484) Empty Project : DSP (1818 Multiplier): 156
MachX02 Breakout Helle World Project CrER = q
MachXO3D Breakout T a
MachX03D PFR Demo ’
DLLs: 2
PCSs: 2
AlUs: 1
DPHYs: 0
PIO Cells: 299
PIO Fins: 359
Template Info:
Empty project for user to "build from scratch®,
< Back Mext = Cancel
Figure 2.6. Specify a Board for a New SoC Project
8. Click Next. The Project Information wizard opens (Figure 2.7).
4. Create System Design >
Project Information
Generate new project with the following specdifications.
Project:
Project Name: EmptyProject
Project Location: Ci/fIscc/workspace/EmptyProject
Language: Verilog
Device: LFCPMNX-100-9LFGET2C
Speed: 9 High-Performance_1.0V
Template Name: Empty Project
< Back Finish Cancel

Figure 2.7. Create System Design — Project Information Wizard

9. Check and confirm the project information.
10. Click Finish. Propel Builder GUI opens (Figure 2.8).

© 2022 Lattice Semiconductor Corp. All Lattice trademarks, registered trademarks, patents, and disclaimers are as listed at www.latticesemi.com/legal
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File Edit View Design Tools Window Help

s B O C M &5 G
Design View m]
u LFCPNX-100-9LFG672C
= 1F EmptyProject
- ZC' Ports

[ ek

[ rstn_i

Coemponents

Properties
Mame:

Type: Instance

Path: EmptyProject

VLMV: lattice:systembuilder:EmptyProject: 1.0

File:  C:flscc/workspace/EmptyProject/EmptyProject/EmptyProject.sbx

IP Catalog Design View 4

Tel Console

%

Schematic

4. Propel Builder [Ci/lscc/workspace/EmptyProject/EmptyProject/EmptyProject.sbx] Device: LFCPNX-100-9LFGE72C Board: CertusPro-NX Evaluation

VS T QQQQ@

Address =, Start Page

clk_i

rstn i

% sbp design open -name EmptyProject -path {C:/lscc/workspace/EmptyProject/EmptyProject/EmptyProject.sbx}

Figure 2.8. Propel Builder GUI Shows Empty Project

2.2.2. Creating Template SoC Project

Templates are customized with common-used programs as well as pre-defined family, device, package, speed and
operating condition. This HelloWorld template is programmed to run HelloWorld demo. You can make changes based

on this template.

1. Choose File > New Design from the Lattice Propel Builder Menu bar. The Create System Design wizard

(Figure 2.9).opens

© 2022 Lattice Semiconductor Corp. All Lattice trademarks, registered trademarks, patents, and disclaimers are as listed at www.latticesemi.com/legal.
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4%, Create System Design X

Design Information
Enter a name for your design and specify a directory where the design files will be stored.

Project:

Type: SoC Project v

Name: Helloworld

Location: ~ C:/lscc/workspace] ¥  Browse...

Create Project at C: lscc/workspace HellowWorld

Next > Cancel
Figure 2.9. Create System Design — Design Information Wizard

The default Project Type is displayed in the Type field. Select SoC Project from the drop-down menu.
Enter a project name in the Name field, such as HelloWorld.

(Optional) The default location is shown in the Location field. Use the Browse... option to change the project
workspace location.

Click Next.

From the Configure Propel Project wizard, you can specify a device or a board for a Template SoC project
(Figure 2.10).

4 Create System Design *
Configure Propel Project
Specify a device or board for project.
Language: Device Information:
: Part Number: LFCPMX-100-7ASG256C
Verilog -
Logic Cells: 96000
Family: Board Processor: LUTs: 79872
LFCPNX (CertusPro-MNX) - RISC-V MC - Registers: 79872
EER Blocks: 208
Device: Templates:
: LRAM: 7
LFCPNX-100 = [NIERENED et DSP (1818 Multiplier): 156
Hello World Project
Package: ADC Blocks: 1
ASGI56 - PLLs: =+
DLLs: 2
Speed: PCSs: z
7_High-Performance_1.0V - ALUs: 1
Operating Condition: DPHYs: 0
: PIO Cells: 299
C i 4
ommerda PIO Pins: 193
Template Info:
Empty project for user to "build from scratch™,
< Back Mext = Cancel

Figure 2.10. Specify a Device for Template SoC Project (1)
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e To specify a device for your new Template SoC project, use the drop-down menu to select desired device
information (Family, Device, Package and Speed), and select Hello World Project from the Templates field
(Figure 2.11).

Note:

Different device families are supported and available in Radiant or Diamond software accordingly.

e Available in Radiant software only: LFCPNX (CertusPro-NX)/LFD2NX (Certus-NX)/LFMXO5 (MachX0O5-NX)/
LIFCL (CrossLink-NX).

e Available in Diamond software only: LFMNX/MachX02/MachX03D/MachXO03L/MachXO3LF.

%, Create System Design X

Configure Propel Project
Specify a device or board for project.

Language: Device Information:
g Part Number: LFCPNX-100-7A5G256C
Verilog
Logic Cells: 96000
Family: Board Processor: LUTs: 79872
LFCPNX (CertusProNX) ¥ | | RISC-vMC v  Registers: 73872
EBR Blocks: 208
_LAV'AT .| Templates:
iLFCPNX (CertusPro-NX) LRAM: 7
LFD2NX (Certus-NX) Empty Project 2
- DSP (18x 18 Multiplier): 156
LFMXOS5 (Mad_wXOS-NX) Hello World Project )
LIFCL (CrossLink-NX) ADC Blocks: 1
LFMNX -
MachX02 e 2
MachX03D DLLs: 2
MachXO3L -
MachXO3LF RS <
T STOTTaTeE=T ALUs: 1
Operating Condition: DPHYs: 0
: PIO Cells: 299
1 v
Commerds PIO Pins: 159
Template Info:
Empty project for user to "build from scratch”,
Online Data Sheet for Device Template Manager
< Back Next > Cancel

Figure 2.11. Specify a Device for Template SoC Project (2)

e  Or, to specify a board for a new Template SoC project, check the Board option (Figure 2.12).
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4 Create System Design x
Configure Propel Project
Specify a device ar board for project.
Language: Device Information:
. Fart Mumber: LFCPMX-100-7ASG256C
Verilog
Logic Cells: 96000
Family: D Board Processor: LUTs: 79872
LFCPNY {CertusPro-Nx) - |RISCVMC Registers: 73872
EBR. Blocks: 208
Device: Templates:
_ LRAM: 7
LFCPNX-100 | EmptyProject DSP (18x18 Multiplier): 156
iHello World Project
Package: ADC Blocks: 1
ASGI56 - PLLs: =
DLLs: 2
foaai PCSs: 2
7_High-Performance_1.0V - ALUs: 1
Operating Condition: DPHYs: 0
| PIO Cells: 297
C 1 -
ommeraa PIO Pins: 193
Template Info:
Hello Warld Project. Components induded:
a) Processor - RISC-V MC w/ PIC/TIMER
b) GPIO
c) ASRAM - Asynchronous SRAM
d) UART - Serial part
Online Data Sheet for Device
< Back Next = Cancel

Figure 2.12. Specify a Board for Template SoC Project (1)

7. The Configure Propel Project wizard is shown (Figure 2.13). From the Board Select area, select the desired board,

such as CertusPro-NX Evaluation.

8. Select a desired template from the Templates area, such as Hello World Project (Figure 2.13).
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4., Create System Design x
Configure Propel Project
Specify a device or board for project.
Language: Device Information:
: Part Number: LFCPMX-100-9LFG672C
Verilog -
Logic Cells: 96000
Board Select: Board Processor: LUTs: 79872
CertusPro-MNX Evaluation RISC-W MC - Registers: 79872
CrossLink-MNX Evaluation Templates: EBR Blocks: 208
Lattice Sentry Demo Board for Mach-Mx (256) e LRAM: 7
Lattice Sentry Demno Board for Mach-MX (484) Empty Project DSP (18x18 Multiplier): 156
MachX02 Breakout Hello World Project T a
MachX03D Breakout B «
MachX03D PFR Demo ’
DLLs: 2
PCSs: 2
ALUs: 1
DPHY's: 1]
PIO Cells: 299
PIO Pins: 358
Template Info:
Hello Waorld Project. Components induded: -
a) Processor - RISC-V MC w/ PIC/TIMER
b) GPIO
c) ASRAM - Asynchronous SRAM
d_} UART - Serial port =
< Back MNext > Cancel
Figure 2.13. Specify a Board for Template SoC Project (2)
9. Click Next. The Project Information wizard opens (Figure 2.14).
4, Create System Design d
Project Information
Generate new project with the following specifications.
Project:
i Project Name: HelloWorld
Project Location: C:flscc/workspace/HelloWorld
Language: Verilog
Device: LFCPMX-100-9LFG672C
Speed: 9_High-Performance_ 1.0V
Template Name: Helle Werld Project
< Back Einish Cancel

Figure 2.14. Project Information Wizard

10. Check and confirm the project information.
11. Click Finish. Propel Builder GUI opens (Figure 2.16).
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All other brand or product names are trademarks or registered trademarks of their respective holders. The specifications and information herein are subject to change without notice

20 FPGA-UG-02177-1.0


http://www.latticesemi.com/legal

s LATTICE

Lattice Propel 2022.1 Builder

MEE o @
Design View o o— addes & startpage
B LFoPNX-100-9LFBET2C
= 1 HelloWorld
= 88 otances
st
shb2aght it
apbinst
TF cpul_inst

v

v T equstion_ modulel.inst

v T gpiedinat

+ 0 osctnat

v 0 e

b 1 sysmemdinst

v EF uantdnat
v 2 pots
bt Nets

+ [ Componerns

User Guide
T, Propel Buider [ o Devce L 672C_Board: CentusPro-NX Evaluation — 0 %
T e T e 1
ERS - | : @ QaQaQ

I | o v
[ ] i

Froperties
Hame:

Trpe: Trstance

Patr: veloierid

LY attce:aystembulder+HeloWeorid: 1.0

Fies  Cifucc/arksnace Heloiorid Meloiorkd Melork.dix

P Cataog Design Vv .
Tl Console

% sbp_design cpen -mame HellcWorld -path (Ci/lscc/workspace/HelloWorld/MelloKorld/HelloKorld.skx)
¥

Figure 2.15. Propel Builder GUI showing HelloWorld Template SoC Project

2.2.3. Opening a SoC Existing Project

[ |
1. Choose File > “— Open Design from Propel Builder GUI Menu, or Click Open Design icon “—' from Propel
Builder Toolbar. The Open sbx dialog opens (Figure 2.16).
4 Open sbx X
« v o » ThisPC + Windows (C) » Iscc » propel » v O 2 Search propel
Organize Mew folder [z~ H 0
" MName - Date modified Type Size
3 Quick access
11 2. File folder
@ OneDrive 20 File folder
ETH\;PC 21 File folder
22 File folder
J 3D Objects
I Desktop
Documents
‘ Downloads
D Music
[&=] Pictures
{8 videos
o Windows (C:)
- Mew Volume (D:)
Q Metwark v
File name: || b Files (*st) v

Figure 2.16. Open Sbhx Dialog

2.  Browse to find the default project workspace folder or your own project workspace folder. Choose the sbx file,

such as HelloWorld.sbx (Figure 2.17).
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4. Open sbx X

&« v AP » ThisPC » Windows (C:) » lscc » workspace » HelloWorld » HelloWorld ~ [J] Search HelloWorld

Organize » New folder == O @

MName

3 Quick access
@ OneDrive

[ This PC

application
lib
| | HelloWeorld.shx

~  Date modified

4/14/2022 10
4/14/2022 10

Type

File folder
File folder

SBX File

1,412K8

_J 30 Objects
I Desktop

|=| Documents
4 Downloads
J Music

&=/ Pictures

m Videos

2= Windows (C:)

o Mew Volume (D:)

¥ Network

File name: | HelloWorld.sbx v‘ Sbx Files (*.sbx) -

Cancel

Figure 2.17. Open HelloWorld Project

3. Click Open. The Builder GUI shows the SoC design.

Note: Choose File > Recent Designs from Propel Builder GUI Menu. You can quickly open a most recently closed
project.

2.2.4. Adding Modules

After starting a Propel Builder project, you can add modules by dragging them from the IP Catalog view to the
Schematic view. The IP Catalog view comes with a large variety of modules for common use and some glue logic
modules as well, which can be found from the IP on Local tab (Figure 2.18). Click the IP on Server tab to find and
download more modules for specialized use.

1. (Optional) From the Propel Builder GUI IP Catalog area (Figure 2.18), choose the IP on Server tab. Select a desired

4
IP. Click the ™= Install button. After the IP is installed successfully, the new IP can be shown in the IP on Local tab.
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IP Catalog O
sy -

IF on Local IF on Server T-
1 Module/IP on Local
* Module

k |E'| Architecture_Modules
» EI Arithmetic_Modules
k |E'| Mernory_Modules
» EI Processors_Controllers_and_Peripherals
¥ [ Verification IP
- P

k |E'| Processors_Controllers_and_Peripherals

S
1E . I = nus-E
rtl equation split
}aus ~l>u—
concat invert
IF Catalog Design View

Figure 2.18. IP Catalog

2. Fromthe IP on Local tab, select a desired IP, such as GPIO. Double-click the IP module or drag and drop the IP
module to the Schematic view. A Module/IP Block wizard pops up (Figure 2.19).
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4., Module/IP Block Wizard x
Generate Component from IP gpio Version 1.6.0
This wizard will guide you through the configuration, generation and instantiation of this Module/TP. Enter the following
information to get started.
Component name:  gpio0
Create in:
Next = Cancel
Figure 2.19. Module/IP Block Wizard — Generate Component from Module gpio Version 1.6.0
3. Enter a component name in the Component name area, such as gpio0. Click Next. Module/IP Block Wizard shows

the Configure Component from IP gpio Version 1.6.0 page (Figure 2.20).

<, Module/IP Block Wizard X

Configure Component from Module gpio Version 1.6.0
Set the following parameters to configure this component.

Diagram gpiod Configure gpioQ:
*| Property Value
~ General
MNumber of I/ Lines [1-32] 1

Remove Tri-State Buffer
Initial Output Value (hex) [0 - FFFFFFFF] |0

gpio0 I0 Direction (hex) [0 - FFFFFFFF] 1

4hPB_S0 _
aci RE

gpio_io[0:0]

Interface APE

resetn_i

gpio

1 » | No DRC issues are found.

< Back Generate Cancel

Figure 2.20. Module/IP Block Wizard - Configure Component from IP Gpio Version 1.6.0

(Optional) Click the Value field. You can enter a desired value for a property, check the checkbox to select a
property, or select a desired value from the dropdown menu for a property in the Value area. By changing the
value, the properties are thus configured. The property in gray is not configurable.

Click Generate. Module/IP Block wizard shows the Check Generated Result page (Figure 2.21).

24
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4. Module/IP Block Wizard x

Check Generated Result
Chedk the generated component results in the panel below. Unchedk option 'Insert to project’ if you
do not want to add this component to your design.

Component ‘gpio’ is successfully generated.
Module: gpio  Version: 1.6.0

Vendor: latticesemi.com

Language: Verilog

Generated files:

IP-XACT _compaonent: companent, xml
IP-XACT_design: design.xml
black_box_verilog: rilfgpio0_bb.v

cfg: gpio0.cfg

IP package file: gpiol.ipx
template_verilog: misc/gpio0_tmpl.v
dependency_file: testbench/dut_inst.v
dependency_file: testbench/dut_params.v
template_vhdl: misc/gpio0_tmpl. vhd
top_level_verilog: rilfgpio0. v

Insert to project

< Back Finish

Figure 2.21. Module/IP Block Wizard - Check Generated Result

Select Insert to project (Figure 2.21) at the bottom of the Check Generate Result wizard.
Click Finish. The Define Instance dialog box opens (Figure 2.22).

4. Define Instance 7 *

Instance Mame: gpiod_inst
Instance Reference: gpiod;1.6.0

QK Cancel

Figure 2.22. Design Instance Dialog Box

(Optional) Change the instance name, if desired. Space and special characters are not allowed.

Click OK. The schematic block for the module appears in the Schematic view (Figure 2.23).
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. Propel Builder [C:/Iscc/workspace/EmptyProject/EmptyProject/EmptyProject.sbx] Device: LFCPNX-100-9LFGE72C Board: CertusPro-NX Evaluation - [m} x
Ele Edit View Design Jools Window Help
sBEHR OC A BEE N R & QQQQ
IP Catalog n Schematic Address %, Start Page
jmi s =
IP on Local IP on Server =T
- Processors_Controllers_and_Peripherals i
T System_Memory 111
T AHB-Lite_Feedthrough 1.0.0 . .
& AHB Lite Interconnect 13.0 . gpic0_inst
T AHBLiteto APBBricge 110 clk_i s ~
& APB_Feedthrough 1.0.0
4 APB Interconnect 110
£ AXI4 to AHE Bridge 100 ) g
& AXI4 to APB Bridge 100 rstn_i — |+|APB_SO
4% AXI4 Interconnect 1000 LE r=-
v 9 Verification [P INTP\|+| —
< _ Lia
- Processors_Contrellers_and_Peripherals h— C|k7|
@ cpio 160 @ o
@ Risc-vmMC 220 gpio_iO fem—
@ uvart 130 @
o —t resetn_i
~
,{: nus-E }BUS
rtl equation split concat \ ‘/
™~
S
invert
IP Catalog Design View 4 N 1
Tel Console [m]
% sbp_design open -name EmptyProject -path (C:/lscc/workspace/EmptyProject/EmpryProject/EmpryProject.sbx}
% sbp_design config ip -vinv {latticesemi.com:ip:gpic0:1.6.0} -meta_loc {C:/Users/jzheng/PropslIPLocal/latticesemi.com ip gpio_1.6.0} -cfg {C:/lscc/
workspace/EmptyProject/EmptyProject/.lib/latticesemi.com/ip/gpio0/1.6.0/gpio0.cfg}
% sbp_add_component -vlnv {latticesemi.com:iipigplio0:l.6.0} -name {gpicl_inst}
b

Figure 2.23. Propel Builder Schematic View Shows the Module Instance

2.2.5. Adding Glue Logic

Propel 2022.1 builder supports glue logic modules as well as IP modules. You can add glue logic modules by dragging
them from the IP Catalog view (Figure 2.24) to the Schematic view.
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IP Catalog O

=
R

IP on Local IP on Server T

1 Module/IP on Local
* Module
k ||f'| Architecture_Modules
» EI Arithmetic_Modules
k ||f'| Mernory_Modules
» EI Processors_Controllers_and_Peripherals
¥ [ Verification IP
> [P

b ||f'| Processors_Controllers_and_Peripherals

e
H0f f= wef
rtl equation split
—t=BUS ~I>o—
concat invert
IP Catalog Design View

Figure 2.24. IP Catalog
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Concat
a. From the IP Catalog, select the concat module. Double-click the concat module or drag and drop concat
module to the Schematic view. A Glue Logic wizard (Figure 2.25) pops up.

l#‘
Logic Diagram Configuration
i RHS: | BUS[S5:0]
LHS: | a5
B[3:1]
A[5:4] o
B[3:1]|BUS[5:0]
——

C[0]

oK Cancel

Figure 2.25. Glue Logic for Concat Module

b. Click the RHS field to change the default right-hand side bus width to a desired one. Click the LHS field to

change the default left-hand side bus width to a desired one. Click the Add button to add LHS (Left-

hand Side). Click the Remove button to remove LHS (Left-hand Side). You can only add or remove LHS but
not RHS. LHS and RHS are thus configured.
c. Click OK. The schematic block for the concat module in red appears in the Schematic view (Figure 2.26).

Schematic Address A Start Page

; A[5:4
clk_i —:|

BR[3 BLIS[S
rstn_i S ig 0]

Figure 2.26. Schematic View Shows a Concat Module
Equation

a. From the IP Catalog, select the equation module. Double-click the equation module, or drag and drop the
equation module to the Schematic view. A Glue Logic wizard (Figure 2.27) pops up.
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%, Glue Logic ? X

Logic Diagram Configuration

H Module Name: = equation_module

Expression: O= 1A &IB

equation_module
0

AT AP

oK Cancel

Figure 2.27. Glue Logic Wizard for Equation Module
b. Click the Module Name field to change the default value to a desired name. Click the Expression field to

change the default expression to a desired one. The expression supports and (&), or (|), negation (!). The
module name and expression are thus configured.

c. Click OK. The schematic block for the equation module in red appears in the Schematic view (Figure 2.28).

Schematic Address 4y, Start Page

equation_module_inst

e
-

d)p

ém

Figure 2.28. Schematic View Shows an Equation Module

e |nvert

a. From the IP Catalog, select the invert module. Double-click the invert module or drag and drop invert module
to the Schematic view. The schematic block for the invert module in red appears in the Schematic view
(Figure 2.29).
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Schematic Address 4, Start Page

invert

Figure 2.29. Schematic View Shows the Invert Module

e Ril

a. From the IP Catalog, select the rtl module. Double-click the rtl module or drag and drop the rtl module to the
Schematic view. A Glue Logic wizard (Figure 2.30) pops up.

%, Glue Logic ? X

Logic Diagram Configuration

Use Existing File:

Ril: | module ri_module (input rstn,output out);
endmodule

rtl_module

—rstn outi—

QK Cancel

Figure 2.30. Glue Logic Wizard for Rtl Module

b. You can edit your own rtl module in the Rtl area by entering the rtl module function.
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¢. Oryou can use an existing rtl module by checking the Use Existing File checkbox. After checking the Use
Existing File checkbox (Figure 2.31), browse to find the existing RTL module file path from the Path filed. And,

check the CopyToDesign checkbox, if you want to copy the rtl module to the design.

4. Glue Logic
Logic Diagram Configuration
Use Existing File:
Path: rkspace/test_modulel.v
CopyTaoDesign:
nv
A[2:0]}
—|bb[10:8] Bl
4 3
Ok

*

Cancel

Figure 2.31. Existing Rtl Module Configuration

d. Click OK. The schematic block for the rtl module in red appears in the Schematic view (Figure 2.32).

Schematic Address Ay, Start Page
inv_inst
A[Z:O] —
==l bb[10:8] Bp=—
C

Figure 2.32. Schematic View Shows the Custom Rtl Module

Note: Currently, Rtl Module only supports Verilog HDL.
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e Split

a. From the IP Catalog, select the split module. Double-click the split module, or drag and drop the split module
to the Schematic view. A Glue Logic wizard (Figure 2.33) pops up.

5,
Logic Diagram Configuration
i LHS: | BUS[5:0]
RAS: | alsiq]
B[3:1]
c[o]
A[5:4]
Add Remove
BUS[5:0]|B[3:1]
C[0]
4 3 i
| oK Cancel |

Figure 2.33. Glue Logic Wizard for Split Module

b. Click LHS field to change the default left-hand side bus widths to a desired one. Click RHS field to change the

default right-hand side bit width to a desired one. Click the Add button to add an RHS. Click the
Remave button to remove an RHS. You can only add or remove RHS but not LHS. LHS and RHS are thus
configured.

c. Click OK. The schematic block for the split module in red appears in the Schematic view (Figure 2.34).

Schematic Address . Start Page

BUS[5:0]] B[3:1]

Figure 2.34. Schematic View Shows Split Module
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2.2.6. Undo/Redo

Propel 2022.1 Builder supports one-level undo/redo. You can click the Undo icon from Propel Builder Toolbar to go
back to last action. Click the Redo icon from Propel Builder Toolbar to recover last undo action.

e Undo: Choose Edit > Undo from the Lattice Propel Builder Menu bar. Or, click the Undo icon from
Propel Builder GUI Toolbar.

e Redo: Choose Edit > Redo from the Lattice Propel Builder Menu bar. Or, click the Redo icon from
Propel Builder Toolbar.

Note: Currently, Propel 2022.1 Builder only supports single undo/redo.

2.2.7. Modifying the Project Settings

Propel 2022.1 Builder supports changing the projects settings. You can modify the device, package, speed and
operating conditions by double clicking the device part number from the Design View.

1. Double click the device part number from the Design View (Figure 2.35), the Modify Device Info wizard pops up
(Figure 2.36).

Design View m|
LFCPMX-100-9LFGE72C

- 3 f HelloWorld
= {F Instances

1 E ahbl0_inst

i E ahbl2apb0_inst

1 E apb0_inst

1 E cpul_inst

i F equation_module0_inst

i E gpiol_inst

i F oscO_inst

i E plio_inst

i F sysmem0_inst

i F uartl_inst

¥ -7 Ports

LS E Mets

* ¥ ¥ ¥ ¥ v v v v v

» i Components

Properties
Mame: | cpuld_inst

Type: Instance
Path: HelloWorld/cpud_inst
WLMV:  latticesemi.com:ip:cpud:2. 1.0

IF Catalog Design View

Figure 2.35 Design View of Device Part Number
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2. Use the drop-down menu to choose the desired device in Device filed in the Modify Device Info wizard
(Figure 2.36). Use the drop-down menu to change the package, speed and operating condition in Package, Speed,
Operating Condition filed.

<, Modify Device Info: ? x
Family: Device Information:
Part Mumber: LFCPMX-100-7CBG 2561
T Logic Cells: 96000
Device: LUTs: 70872
LFCPNX-100 - Registers: 79872
Package: EBR. Blocks: 208
LRAM: 7
CBG256 M DSP (18x18 Multiplier): 156
Speed: ADC Blocks: 1
7_High-Performance_1.0v - PLLs: 4
DLLs: 2
Operating Condition: - 5
Industrial 7 AllUs: 1
DPHYs: 0
PIO Cells: 299
PIO Pins: 193
Ok Cancel

Figure 2.36 Modify Device Info

3. Click OK. The System Builder dialog (Figure 2.37) pops up to show the warning message about configuring all IP.

e Systern Builde
This operation needs to configure all IPs in the current project.

Do you want to do this?

Yes Mo |

Figure 2.37 System Builder Dialog

4. Click Yes to configure all IP in current project. The new device part number shows in Design View (Figure 2.38).
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DesignMisw
8| LFCPNX-100-7CBG256!
+ 1 HelloWorld

- 1? Instances

3
3

=
L=

ﬂ equation_modulel_inst
iF ahbl0_inst

1F ahbl2apb0_inst
ﬂ apbl_inst

ﬂ cpul_inst

iE gpiol_inst

ﬂ oscl_inst

IF pli_inst

ﬂ sysmem{_inst
ﬂ uartl_inst
Ports

LIy i Nets
» |£¥ Components

Properties

Mame: | uartl_inst

Type: Instance
Path: HelloWorld fuartd_inst
WLNV:  latticesemi.com:ip:uartD: 1.3.0

IP Catalog Design View

Figure 2.38 Design View of Device Part Number

2.2.8. Working with the Schematic View

You can make changes in the Schematic view including automatic layout to clean up the display, moving, resizing,
renaming blocks manually, highlighting objects and zooming the display in and out.

e To view signal list of block:

Click the plus sign
=1

ryil
L.I.

1
= of the desired block to see what signals it contains. The plus sign changes to a negative sign

r=1

C_J and shows the signal list as shown in Figure 2.39. Click the negative signLTJI to close the expanded bus. The

schematic returns to the previous form.
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gpio0_inst
- -
—~{I—APB_S0
— p-PADDR[5:0]
— PPENABLE
— <4PRDATA[31:0]
— 4PREADY .
INTRi=i =
—  PPSELx e
gpio_io|—
— <«4PSLVERR
—~{ PPWDATA[31:0]
— PPWRITE
—clk_i
—resetn_i
A
Figure 2.39. Signal List of Modules
e To select one or more objects:

Select one object or more objects in one of the following ways:

e  Click on the object in the Schematic view. The selected object turns to red (Figure 2.40).

36
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File Edit View Design Tools Window Help

erBf) élm_‘ﬁ{f

IP Catalog m]

&

[ -.-_E-.- 2 /\\,

Schematic Address

QQaaqQ

A, Start Page
IP on Local 1P on Server T
Q Medule/IP on Local
* Module

3 Architecture_Modules

3 Arithmetic_Modules
» Memory_Modules
-

Processors_Controllers_and_Peripherals

& GPIo 1.6.0
i RISC-V MC 210 dk i gpio0_inst
i RISC-VSM 1.1.0 - (" \
B System_Mernory 103
F UART 130 r<-
5 AHB Lite Interconnect 130 rstn i — |+|AP5750
$4 AHE Lite to APB Bridge 110 : LE_ rs
5% APB Interconnect 110 INTR| | —
b [ Verification IP L=l
- P w— CIK
13 Processors_Controllers_and_Peripherals . .
gPIC_IQ =
w— resetn i
L -
rtl equation split concat invert
Design View IP Catalog

Figure 2.40. Select Object

e  Ctrl-click or Shift-click in the Schematic view to select more than one objects.

e Click the Area_select icon a from the Propel Builder Toolbar. Click and drag to draw a selection rectangle
around the modules and ports in the Schematic view. Click the icon again to turn off the Area_select mode.

e From the Schematic view, right-click and choose Select All or press Ctrl-A to select all the objects.

Note: Ctrl-click or Shift-click on the object in the Schematic view can also de-select the object while leaving the

others selected.

e Tore-arrange the schematic:

Propel Builder allows re-arranging the objects in the schematic view. You can re-arrange modules and the ports.

Drag objects to re-arrange the schematic. Propel Builder has rules for placing objects to adjust the schematic in an

organized arrangement.

a. Select the desired modules (one or more modules can be dragged at the same time) or ports (one or more

ports can be dragged at the same time).
b. Click on the selected items and drag it to the desired location.

c. Release the mouse button.

Note: The selected objects can be moved to the specified location, or as near as the rules allow. Other objects in

the schematic can also be moved to accommodate the selected objects’ new location.

e To bring selected objects to the center of the Schematic view using the Locate Object mode:

a. Click the Locate Object icon 17 from the Propel Builder Toolbar. The background turns to dark gray.

b. Select the object in the List view of the Design View. The selected object is in the center of the Schematic View

(Figure 2.41).
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e To automatically simplify the layout:
Right-click anywhere in the Schematic view and choose Relayout.

e To duplicate a module:

File Edit View Design Tools Window Help
o= - ] NG 5
o= H 9 2 RO E x 90 £ QQ@aa@
Design View m} Schematic Address Ay, Start Page
3 LFCPNX-100-8LFGE72C a
= 1F EmptyProject
» 20 Ports
A 1? Instances
v iF gpioO_inst
3 Components
. : I gpio0_inst I
clk_i 7 - - ~\
) : ryga
rstn_i - | 1APB_S0
L=d ry-
INTR|+| o
, LI
— clk_]
gPIO_iO fprmm—
— resetn i
Properties
MName: = gpio0_inst
Type: Instance
Path: EmptyProjectfgpio0_inst
WLNV:  latticesemi.com:ip:gpio0: 1.6.0
Design View IP Catalog 0 B 3
Figure 2.41. Locate Objects

. A copy of the

Select the desired module and click Clone * . Or right-click on the module and choose Clone !
schematic block appears with a new instance name (Figure 2.42).
gpio0_inst gpic0_inst_0O
' N ' N
i (=1 APB_S0 = [=1APB_S0
L= ry L2d r=A
INTR | e INTR e e
. L=d . L=l
—clk_i —clk_i
gpio_io— gpio_iol—
—resetn_i —{resetn_i
. J . J

Figure 2.42. Duplicate a Module
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To restore a deleted module:
In the List view of the Design View (Figure 2.43), go to the Components folder. The deleted module can still be

a.
found in the List view in plain text. Those not deleted are shown in bold-faced text.

m|

Design View
E LFCPMNX-100-9LFGET2C
= 1F EmptyProject
K 3:- Ports
A iﬁt Instances
v 1E gpiol_inst
v 1 gpio0_inst_0
= |i¥| Components
|| gpio0:1.6.0
|| gpiol_0:1.6.0
|E| aph0:1.0.0

Properties
MNarme:

Type: Instance

Path: EmptyProject

VLMY  lattice:systembuilder:EmptyProject: 1.0

File:  C:flsccfworkspace EmptyProject/EmptyProject/EmptyProject. sbix

IP Catalog Design View

Figure 2.43. Design View

b. Right-click on the desired component and choose Instantiate. The Define Instance dialog box (Figure 2.44)

open.

. Define Instance ? >

Instance Name: apbl_inst
Instance Reference: apb0:1.1.0
oK Cancel

Figure 2.44. Define Instance Dialog Box
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c. Enter a name for the new instance.

d. Click OK. The module appears in the Schematic view and the List view of Design Info, and the component
name is bold-faced.

e To reconfigure a module:

a. Double-click the module, or right-click the module. Choose Reconfig. The Module/IP Block wizard (Figure 2.45)
opens.

%, Module/IP Block Wizard s

Configure Component from Module apb_interconnect Version 1.1.0
Set the following parameters to configure this component.

Diagram apb Configure IP
General Main Settings Master Priority Settings
Property Value
~ General
Total APB Masters [1 - 32] 2
Total APB Slaves [1 - 32] 2
Master Address Width(bits) 32
apb0
Data Bus Width(bits) 32
—[HHars_soo
—HHarB_s01  APB_MOOHH—
—apb_pclk_i APB_MO1[4H=~
—apb_presetn_i

apb_interconnect

4 4 Mo DRC issues are found,

Generate Cancel

Figure 2.45. Module/IP Block Wizard — Configure Component

b. Configure component (including General property, Main Settings and Mater Priority Settings) at Configure IP
table in the Module/IP Block Wizard. Click Generate to generate the module as usual. The schematic block for
the module changes to match the new configuration.

Note: For a SoC design, if the init file (mem file) of System Memory module instance is updated in a C project, the

initialization section of the system memory module instance should be re-configured. Or, use the ECO flow to

update the information. Refer to the Diamond online help for more on how to use an ECO flow.
e To resize module blocks:

a. Select the desired module block. The block is highlighted in red with black corners (Figure 2.46).
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F apb0_inst -|
= APB_S00
=1 HAPB_S01  APB_MOO 4 =
—{apb_pclk_i APB_MO1 4l f=
—lapb_presetn_i
L |

Figure 2.46. Select Module

b. Click and drag one of the corners to change the size and shape of the block.
c. Release the mouse button. All the other objects move to make room for this block.
Note: Right-click the module block and choose Unresize Instance to restore the size of the module block.

There are a variety of methods to zoom within the Schematic view, including toolbar commands and dragging in the
Schematic view.

The following commands are available from the Propel Builder Toolbar.
e Zoom In (Ctrl++) @ — enlarges the view of the entire layout.
e Zoom Out (Ctrl+-) Q — reduces the view of the entire layout.

e Zoom Fit — reduces or enlarges the entire layout so that it fits inside the window.
l/b\
e Zoom To A _ enlarges the size of one or more selected objects on the layout and fills the window with
selection.
Note: The mouse wheel provides a finer zoom control by rolling the mouse wheel forward to zoom in and
backward to zoom out while pressing the Ctrl key.

e Tozoom by holding the mouse button and dragging.
e To zoom to fit the window, drag up and to the left. The image adjusts to fill the window.

e To zoom out, drag up and to the right. The dragging distance determines the amount of zoom. The image is
reduced and centered in the window.

e Tozoom in, drag down and to the left. The dragging distance determines the amount of zoom. The image is
enlarged and centered in the window.

e Tozoom in in a specific area, start at the upper-left corner of the area and drag to the lower-right corner of the
area. The area that dragging across is adjusted to fill the window.

Note: Make sure that the Area_select icon a is not selected in the Toolbar. If you need to use Area_select and
zoom by dragging frequently, choose Design > Options from Propel Builder menu bar. The Options Dialog opens
(Figure 2.47). Select Use right mouse button for zooming actions and click OK. Then you can select an instance

using the left mouse button, zoom in or zoom out using the right mouse button, and the Area_select icon d
disappears from the Propel Builder Toolbar.
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4. Options ? x
Themes: Light -
General Color Metwork Settings Directories

Use right mouse button for zooming actions

Set Default

K Cancel Apply

Figure 2.47. Options Dialog

e To move the schematic image within the Schematic view by panning and scrolling.

e To pan the image: Hold down the Ctrl key and the left mouse button while dragging the image.

e To scroll vertically: Rotate the mouse wheel. Or, click in the vertical scroll bar.

e To scroll horizontally: Hold down the Shift key and rotate the mouse wheel. Or, click in the horizontal scroll bar.
e To show the connectivity of a module: right-click the module and choose Show connectivity. All nets connected to

the module, all pins and ports connected to the nets are highlighted (Figure 2.48).
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File Edit View Design Tools Window Help

cEH VWCT A REEFNGHZERNS QQQ@
Design View o Schematic Address &, StartPage
8 LFCPNX-100-0LFG672C =
~ I HelloWerld
= 4 Instances
» 1 ahbl0_inst
b iF ahbl2apb0_inst
» 1F apb_inst
» 1E cpudiinst
» I equation_moduled_inst
» I gpiodinst
» I oscO_inst
v I pll0_inst
v IE sysmem0inst
» IF vartlinst
» = Ports
> i Nets
» Components

Properties

Name: | cpud_inst

Type: Instance
Path:  HelloWWorld/cpud_inst
VLNY:  latticesemi, com:ip:cpu0:2. 1.0

P Catalog Design View

Figure 2.48. Show Connectivity of the Module

<,
e To highlight an object: select an object and click Highlight ‘A or, right-click the object and choose Highlight

2 b
. The object is highlighted in blue (Figure 2.49). Click Highlight again. You can remove highlighting.

gpio0_inst

RAPB_S0 i
e INTRIH
clk_i ==

gpio_io
resetn_i

Figure 2.49. Highlight an Object

e To change the name of an object:

a. Select the object from the List view of Design View. Information of the selected object is shown in the
Properties area (Figure 2.50).
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Properties

Mame: | gpiol_inst

Type: Instance
Path: HelloWorld/gpio0_inst
VLMY:  latticesemi.com:ip:gpiod: 1.6.0

Figure 2.50. Object Properties

b. Change the name and click Enter. The name changes in the Schematic view and List view of Design Info.

e To print a schematic:
a. Choose File > Print Preview. The Print Preview window (Figure 2.51) opens.

14, Print Preview: Schematic

95.9%'8\9\ @‘4¢f1$$' Eﬁ@

Figure 2.51. Print Preview

b. Expand the Print Preview window to the desired size.

c. Click the Page Setup button f and adjust the paper size and margins, if necessary.

d. Click the Print button é._t: .
e. Adjust the printer settings, if necessary. Click Print.
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2.2.9. Connecting Modules

You can connect the pins of modules to other modules or to top-level ports by dragging a line between them or by
selecting connection points, or by assigning a constant value to an input pin or bus. Propel Builder does not allow
obvious inappropriate connections, such as a connection between two output pins or mismatched buses.

e To connect modules by drawing:

a. Move the cursor to a pin or port. The cursor changes to a pencil icon 17 click and hold while dragging to
another pin, port, or net. An allowed pin or port shows a green checkmark when you hover over it
(Figure 2.52). An allowed net becomes bold when you hover over it (Figure 2.53).

apb0_inst
e PO ~ gpio0_inst
g
= i1APB_S00 Vo= TF1APB_SO
= L. — ry
— r_l__l APB_S01 APB_MO0L+_= L=d INTRL+J'
L= _ — clk_i -
—apb_pclk_i APB_MO1{ufe| e gpio_io
. L= resetn i
—apb_presetn_i
A vy
Figure 2.52. Draw a Pin or a Port
y sysmemO_inst
cpuO_inst e
8 =) ri
" i--AHBL_S0
~|EEE.=0 - .:-;-':.AHBL 51
~|EHRQ.S1 _ahbl_helk i
—FHIRQ_S2 R
— — ahbl_hresetn_i
= i+IRQ_S3AHBL_MO_INSTRi4-i =
— FHIRQ_S4 AHBL_M1_DATAL
— [—HIRQ_SS TIMER;IRQ_MO[E e
—FRIRQ.56  system_resetn_o|—
_=FRIRQ_S7
clk_i ck_i
rstn_i rst_n_i
\ J

Figure 2.53. Draw Nets

b. Click on the pin, port, or net that you want to connect to. If the connection is allowed, a line appears
connecting the two objects. Propel Builder creates a path around other objects.

c. You can connect multiple ports once. When more than one port are selected (Figure 2.54), click connect “*
from the right-click menu to implement it.
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Figure 2.54. Select More than One Ports

d. When the net is complete, right-click to leave the drawing mode.
e To connect modules by selecting points:

a. Select the pins, ports, and nets that you want to connect.

o—;

]

b. Right-click one of the selected objects. Choose Connect — .
e To connect pins by auto connecting:

a. Right-click a bank and choose Auto Connect (Figure 2.55). The Connect Ports dialog appears (Figure 2.56).
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system0_inst

P bbb
—{ R AHBL_S0

— FHAHBL_S1
—ahbl_hresetn_i
—ahbl_hclk_i

A

Create Port
I Auto Connect |
Create Cormment
ﬁ Yalidate Design
Select All
Belayout

Figure 2.55. Action Menu of Right-clicking on Blank

b. By default, Auto connect selects all ports. You can also deselect the interface/clock/rest pins that you do
not want to auto-connect (Figure 2.56).
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., Connect Ports ? x

Drriver Destination
Clock/Reset Connection
cpul_inst/clk_i
ahbl0_inst/ahbl_hclk_i
oseD_instfnf_ck_out_o ahbl2apb0_inst/clk_i

ahbl2apb0_inst/pcll_i

plio_inst/dkop_o apbl_inst/apb_pclk_i
gpio0_inst/clk_i
pllo_inst/ckos_o pll0_inst/clki_i

sysmem{_inst/ahbl_hclk_i

uartl_inst/clk_i

[] cpull_inst/rst_n_i

ahbl0_inst/ahbl_hresetn_i

ahbl2apb0_inst/presetn_i
cpul_inst/system_resetn_o

ahbl2apb0_inst/rst_n_i

apb(_inst/apb_presetn_i

gpiol_inst/resetn_i

rstn_i
pll0_inst/rstn_i
sysmem{_inst/ahbl_hresetn_i
uartl_inst/rst_n_i

Interface Connection

cpul_inst/AHBL_M1_DATA ahbl0_inst/AHBL_S00

ahblI0_inst/AHBL_MOD ahbl2apb0_inst/AHBL_S0
ahbl2apb0_inst/APE_MO aphl_inst/APB_500
ahbl0_inst/AHBL_MO1 sysmem(_inst/AHBL_S0
apb0_inst/APB_MOD gpiol_inst/APB_S0
apb0_inst/APB_MO1 uartl_inst/APB_S0
gpio0_inst/INTR cpul_inst/IRC_S0
uartl_inst/INT_MO cpul_inst/IRC_S51
Others

ned_i uartd_inst/red_i
uartD_inst/ted_o td_o

oK Cancel

Figure 2.56. Action Menu of Connecting Ports

Auto connect Rules

Auto connect can initialize three types of connections: Clock/Reset connection, Interface connection, and other
connection.

e Clock/Reset Connection
For clock/reset connection, you can choose only one clock port and one reset port in the Driver selection area.

In the example below, you can choose only one clock port from oscO_inst.hf_clk_out_o, pllO_inst.clkop_o, or
pll0_inst.clkos_o, and one reset port from cpuQ_inst.system_reset_n_0 or rstn_i (Figure 2.57).
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#. Connect Ports

Driver

Clock/Reset Connection

Destination

osc_inst/hf_dk_out_o

plio_inst/dkop_o

pllio_instfdkos_o

[ cpul_inst/clk_i

2 ahbl0_inst/ahbl_hclk_i

[ ahbl2apbl_inst/clk_i

[ ahbl2aph0_inst/pcli_i

[ apb0_inst/apb_pcli_i

[ gpiol_inst/clk_i

B pll0_inst/clki_i

1 sysmem(_inst/ahbl_hclk_i

B uart0_inst/clk_i

rstn_i

cpul_inst/system_resetn_o

[] cpul_inst/rst_n_i

[ ahbl0_inst/ahbl_hresetn_i
[ ahbl2apbl_inst/presetn_i
[ ahbl2apb0_inst/rst_n_i
[ apb0_inst/apb_presetn_i
[ gpiol_inst/resetn_i

[ pll0_inst/rstn_i

1 sysmem(_inst/ahbl_hresetn_i

3 uartd_inst/rst_n_i

Figure 2.57. Select One Clock/Reset Port

Following are rules of how clock/reset driver port auto connects to the destination.

e Whether or not the SoC project contains a CPU instance.

If the SoC project contains a CPU instance, and the CPU instance has an output clock/reset port, such as

cpuO_inst.system_resetn_o (Figure 2.58), the clock/reset of other instances are thus connected to the clock/reset port

of the CPU Instance (Figure 2.58).

I q:luU_insthysbem_resem_oI

rstm_i

Figure 2.58. Connecting CPU Instance Reset Output Port

[ ahbl0_inst/ahbl_hresetn_i

[ ahblZapb0_inst/presetn_i

[ ahbl2apb0_inst/rst_n_i

] apb0_inst/apb_presetn_i

] gpiol_instresetn_i

] pli0_inst/rstn_i

[ sysmeml_inst/ahbl_hresetn_i

1 uartd inst/rst_n_i

[] cpul_inst/rst_n_i

If the SoC project does not contain a CPU instance, clock/reset on all instances connect to the top clock/reset port. Top
clock/reset port is the port such as rstn_i in Figure 2.58.
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The output clock/reset port on one instance should not be connected to its own clock/reset input port, for example,
cpuO_inst.system_resetn_o should not connect to cpuQ_inst.rst_n_i in Figure 2.58.

e [nterface Connection

Bus interfaces can only connect from one interface to another interface. It is a one-to-one relation, not a
one-to-multiple relation, and the interfaces must have the same interface type.

In the example below (see Figure 2.59), cpu0_inst. AHBL_M1_DATA is a bus interface, and it can only connect to one
destination, ahblO_inst.AHBL_S00. Because they have the same interface type: AHBLite. For interface type, you can
check the Bus Type in Design View (Figure 2.59).

DESHYiER] =] Schematc Address % startPage
» @& AHBL M1_DATA ] |
» ) IRQS0
» b IRQST
» & TIMERIRQ_MO
» 1F equation_module_inst
» IF gpiol_inst
- F oscllinst
b+ 3 Ports
- I plioinst
b 2= Ports
v {E system_inst
b IE vartd inst
» 2= Ports
» i Nets
+ [#] Components
[ CPLD interface0:1.1.0
[ cpuo2.2.0
[ gpio0:1.6.0
[ epion140
[ 12€ filter0:1.0.0
[ Pice:1.00
] sFeo1.0.0
2] sFe _interface0:1.0.0
[ system0:1.1.1
[ vart01.1.0
[ vart0:1.3.0
[ ahbloi1.1.2 =

Properties
Name: AHBL_M1_DATA
Type: Piniface
Mode: Master

Path: tis/cpu0_inst/AHEL_M1 DATA -

TP Catalog Design View 0

Figure 2.59. Interface Type of cpu0_inst. AHBL_M1_DATA

Following rules are how interface connect.

If project contains a CPU instance, the interface connection starts from the CPU instance, then to one bus/bridge
instance, and then to another bus/bridge instance. After connecting all bus/bridge instances one by one (cpu0 > ahbl0
> ahbl2apb0 > apb0), finally connects to other instances (gpio0, uart0). See Figure 2.60 and Figure 2.61.

system0_inst

gpio0_inst

J cpul_inst ahbld_inst I
SIRQ_S0AHBL_MD_INSTRES F AHEL_S00 . |
RQ_S1AHBL_MI_DATA; | i =
Tk _i TIMER_IRQ_MOF[] = bl_hdlk_i i |
o system_resetn < ahbl2aph0_inst 1

aph0_inst

Figure 2.60. Interface Connection on from CPU to Bus/Bridge instances in Schematic View
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Interface Connection

cpul_inst/AHBL_M1_DATA [ ahbl0_inst/AHBL_S0D

ahbl0_inst/AHBL_MOD [ ahbl2apb0_inst/AHBL_SO
ahbl2apb0_inst/APB_MO [ apb0_inst/APE_S00
ahbl0_inst/AHBL_MO1 B sysmem0_inst/AHBL_S0
apb0_inst/APB_MOD B gpio0_inst/APE_SD
apb0_inst/APB_MD1 B uartd_inst/APE S0
gpio0_inst/INTR [ cpul_inst/IRQ_SD
uartQ_inst/INT_MOD = cpul_inst/IRQ_51

Figure 2.61. Interface Connection from CPU to Bus/Bridge Instances in Connect Port view

If the last instance connected has the same bus interface type as CPU instance, then it connects back to CPU instance
(see Figure 2.62 and Figure 2.63). In Figure 2.64 and Figure 2.65, you can see gpio0O_inst.INTR and cpu0_inst.IRQ_SO
have the bus type: Interrupt.

—J cpul_inst

FHIRQ_SoAHBL_MD_INSTREL}
FRIRQ S1AHEL M1 DATAZ
Tk _i TIMER_IRQ_MOFE}

systemi_inst
TEAHBL_SD gpio0_inst
= [TAHBL_S1
&EU e AP0 o
|_hresetn i . sl
hb|_hck_i ' g o[70)l
| i
L
ahblo_inst
= I uart0_inst
| tHare_so
ki INT_MOE
ahbl2apb0_inst t_n_i ted_of—

‘ st n i system_resetn, ¢

apbi_inst

Figure 2.62. Interface connection on other instances connect back to CPU in Schematic View

Interface Connection

cpul_inst/AHBL_M1_DATA [ ahbl0_inst/AHBL_500

ahbl0_inst/AHBL_MOD [ ahbl2aph0_inst/AHBL_SO

ahbl2apb0_inst/APB_MOD [ apb0_inst/APB_S00

ahbl0_inst/AHBL_MO1 [ sysmem0_inst/AHBL_SD

apb0)_inst/APB_MOD [ gpiod_inst/APB_SO

apb{_inst/APB_MO1 B vart)_inst/APB_S0

IgpioO_insU’INTR B cpul_inst/IRQ_SD I
uartl_inst/INT_MOD [ cpul_inst/IRO_51

Figure 2.63. Interface connection on other instances connect back to CPU in Connect Port view
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Design View a] Schematic Address % Start Page
» & AHBL_MI_DATA “ 5
» 9 IRQSO
» D IRQST
» b TIMERIRO_MO
» 1} equation_module_inst
~ 1% gpiol_inst
» o Ports
v = Buslnterfaces
> ) APBSO
» ® INR
w 1} oscOinst
» == Ports
~ 1} pli0inst
» 5 Ports
» I} systemo_inst
» I uartd inst
b 2 Pos
b Nets
- Components
[2F] CPLD_interfaced:1.1.0
[ cpud:2.2.0
1] gpic0:1.6.0
[ Gpio1:1.4.0
[T 12€ filterd:1.0.0
[ pico:1.00
[ sFeo:1.00
1] sFB_interface0:1.0.0 vl

Properties
Neme: IR
Type: Piniface
Mode: ___waster

path: ts/gpio0_inst/INTR -

P Catalog Design View 3

Figure 2.64. Interface Type of gpio0_inst.INTR

Design View Schematic Address @ Start Page
v RQSO A
v RQST
+ TIMER,IRQ_MD
1} equation_module inst
O gpiod_inst
» & Pens
o Busintestaces
9 APBSD
» e NTR
v osch inst
£ pind inst
15 systemd jnst
v 10 uandinst
v = Pors
v i Nets
1 cpud_inst_system_resetn_o_net
“. equation_module_jnst_O_net

‘

e =

il e e

o e

Figure 2.65. Interface Type of cpu0_inst.IRQ_SO

If the project does not contain CPU instance, the interface connection starts from the bus/bridge instance, and then to
each bus/bridge instance one by one, and finally connects to the other instances.
Note: If the bus interface is an instruction set, such as CPUO_inst. AHBL_MO_INSTR, it does not perform auto-connect.

e  Other connection
If ports have the same port name, for example, rxd_i and uartO_ins.rdx_i, they are connected.

e To assign a constant value to an input pin:
a. Select the desired pin and right-click the pin. Choose Assign Constant Value (Figure 2.66).

© 2022 Lattice Semiconductor Corp. All Lattice trademarks, registered trademarks, patents, and disclaimers are as listed at www.latticesemi.com/legal.
All other brand or product names are trademarks or registered trademarks of their respective holders. The specifications and information herein are subject to change without notice

52 FPGA-UG-02177-1.0


http://www.latticesemi.com/legal

::LATTICE Lattice Propel 2022.1 Builder

User Guide

sysmem0_inst

— FFAHBL_S50
—~ FRAHBL_S1

—3hb Copy Full Path

%% Highlight

= Connect

Assign Constant Value

[ Export
Create Port
Auto connect
Create Comment
ﬁ Validate Design
Select All
Relayout

Figure 2.66. Action Menu of Right-clicking an Input Pin

sysmemi_inst

HFAHBL_S0
MFAHBL_S1

ahbl_hclk

—_Assign constant value:

ob VA 4

Figure 2.67. Dialog Box of Assigning Constant Value to an Input Pin

b. A small dialog box appears (Figure 2.67). Enter the desired value. To erase the value and start over, click X. For
all buses (more than one pin), the format is hexadecimal. Make sure the value fits the number of pins in the
bus. For example, a 3-pin bus can accept 0-7, but not 8.

e  Usually, disconnecting modules just means deleting a net. If the net has multiple branches, just delete one branch,
leaving the rest of the nets intact.

e To disconnect one branch of a net, right-click the pin of that branch and choose ~ Disconnect. The branch
going to that pin disappears.

e To disconnect a whole net, right-click the net and choose Delete. The whole net is deleted.
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2.2.10. Creating Top-Level Ports

With multiple modules in a Propel Builder project, top-level ports need to be created for a complete Propel Builder
module. You can create a top-level port either manually or automatically.

For input ports that connect to more than one pin, such as for clock and reset signals, the manual way is more
convenient than the automatic way. If the port names automatically-generated need to be changed, the manual way is
better.
For other pins, the automatic way is usually preferred. The automatic way enables you to create the appropriate port
type and connect net simultaneously. The automatic way can also create multiple ports at the same time.
The automatic way of creating ports is the most effective. If all the modules are selected, Propel Builder can
automatically create ports for all the remaining unconnected pins for selected modules in one step.
e To create a port for a pin or bus manually:

a. Right-click in the Schematic view, and choose Create Port. The Create Port dialog box pops up (Figure 2.68).

., Create Port ? >
Mame: input_paort
Direction: Input 7
Type: General -
Bus Options:

(0]4 Cancel

Figure 2.68. Create Port Dialog Box

b. Enter a name for the port in the Name field.
Choose a direction for the port, such as Input in the Direction field.
d. Choose the port type from the Type field. The default type is General.

e. (Optional) Select the Bus Options. Enter the number for the most significant bit (MSB) and the least significant
bit (LSB). These two options define the bus width.

f.  Click OK. The port appears. Figure 2.69 shows an input port, port name of which is on the left. Figure 2.70
shows an output port and an inout port, port names of which are on the right.

input_port [ >

Figure 2.69. Input Port

{_> Inout_port
[ output_port

Figure 2.70. Output Port and Inout Port

g. Connect the port to the module pins. Refer to the Connecting Modules section for more details.
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e Tocreate ports automatically:

a. Select the pins that are to be connected to the top-level ports. All the pins in a module can be selected by
clicking its block. Any pins that are already connected to a net or a constant value are skipped.

b. Right-click on one of the selected pins, interfaces or modules, and choose B’Export. The selected pins are

extended by lines to new top-level port symbols. The names of the ports and nets are added to the List view.
Zoom out or scroll the image in the Schematic view to see the new ports.

c. Portor net names can be changed, if needed.
e To modify port:

a. Click on port, Properties window open (Figure 2.71)

%, Propel Builder

5 Devices LFCPN-100-9LFGBT2C Board: CetusPro-HX Evaluation(A) - a8 x
Ele Edt View Design ook Window Help

FRSY | A ARk @Ee o QQaaq
Design View =]
LFCOMC 1005 FGE72C
Hellwera
¥ Instances
» #hbl inst
} nbizoph it
ottt
st
+ L cquabon o inst
I gpicd,

Schematc Addess % start Page

Fa eloworkdiem §
Comcson

el Consale

pace_test/HelloWorld/HelloWorld/HelloWoz id. abx]

Figure 2.71. Properties of Port
Port direction can be modified. You can use the drop-down menu to choose the desired port direction. TCL
command is shown in Design View. (Figure 2.72).

Note: Port width can only be modified if it is already multi-bit. An error message is prompted out or shown in
TCL console, if the input value does not meet rules (Figure 2.72).
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e L= bw] Device: LFCH Board: CertusPro-NX.
File Edit View Design Jool Window Help

sERAOYCHNA RSB TS @@ @a
Doy B Schematc  Address &, Start Page
B LFCPNX-100-9LFG672C
= 1 HelloWodd!
~ & Instances
v 4 ahbiinst
1 ahbiZapb0_inst
5 opbinst
0 cpulina
¥ equation_moduled inst
T gpiod_inst
£F oscl_inst
0 plo_jnst L

ot - .
& led o070l

v
,

,

' 0.

v 3 sysmemdinst i o

v T} uani inst _4I,___,_‘ b
- - -

e sl

™ mdi

& st

TN

e
i~ :.:m:}ﬁE" == - : T

+ [#] Components

Hame: | st
Toe:  por

ovecton: |t S
Poth: HeloWiordfetn i

o

Tl Console

% sbp_design open -name HelloWorldl -path (C:/Users/jzheng/HelloWorldl/HelloKorldl/HelloWorldl.abx)
4 sbp_modify port -name HelloWorldl/rstn i -direction ocutput

s

Figure 2.72. Port Direction

c. PortBus MSB, LSB and direction can be modified. Click on PortBus and then use the drop-down menu to
choose the desired direction.

Note: An error message is prompted out or shown in TCL console, if the input value does not meet rules
(Figure 2.73).

% Prop ic Device: LECPNA- 100- 81768720 Boareh CertusPro-NK Evaluationl2) -
Fle Edt Vew Design Jooks Window Help

cEBRHCHA MBI NeBUES @AQQ@

Design View o Schematic Address & start Page

I LCPN-100-aLFGETZC
- 2 HelloWerldl

T eput
S equation module inst
£ gpisd jnst

,
,
y
v 1) esclinst
,
,

— . D
- D
o=s e
| ey
] g )
T T -
-
[om— J5m e
Vome: [ ied.0
Tyoe:  Portbus
v s
= o
Drection: | output -
Path: Heloiworid Led o
Tel Console [=]

% 3bp_deaign open -name HelloKorldi -path (C:/Users/zheng/HelloWorldi/HelloKoridl/HelloWoridl.sbx)
% sbp_modify pors -name HelloKorldi/ratn_i -dizection oucpus

% 3bp_medify_port -name HelloWorldl/led_o -Girection Anout -from 7 -to O

% sbp_modify porc -name HelloWorldl/led o -direction inout -from 7 -to O

% sbp_medify porc -name HelloWorldl/led o -Girecrion OUTPHT -LEom 7 -to

% sbp_modify_porv -name HelloWorldl/led o -direction output -from 8 -to 0

s

Figure 2.73. PortBus Direction
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2.2.11. Adjusting Address Spaces

The Address view shows the base address, size of the address segment, and the end address for each leaf
memory-mapped slave connection in the Propel Builder project. Propel Builder can automatically assign address
values, while the base address value can be changed manually. The addresses are automatically assigned when master
and slave components were connected. The ranges are set when the modules are configured. The end addresses are
calculated.

The Lock option on each address space prevents Auto Assign from changing the base address value. The Lock option is
selected automatically when you manually change the address value. To reset the address space, clear the Lock option
before clicking the Auto Assign icon.

Note: There is no Lock option on LocalMemory. The value of the base address can always be changed, while Auto
Assign does not reset it to its original value.

1. Inthe Propel Builder main window, click the Address tab. The Address view (Figure 2.74) shows.

Schematic Address Ay Start Page
Cell Base Address Range End Address  Lock
~ cpul_inst 000000000
~ LocalMemory
«cpul_inst/pic_timer_registers 0xFFFFO000 2K 0xFFFFO7FF

~ cpul_inst/AHEL_MO_INSTR(32 address bits: 4G)

sysmem(_inst/AHBL_S0 0x00000000 32K 0x00007FFF
~ cpul_inst/AHBL_M1_DATA(32 address bits: 4G) 0x00007FFF
0x00003000

gpiol_inst/APB_S0 000008400 1K 0x000087FF

sysmem(_inst/AHBL_51 0x00000000 32K 0x00007FFF
uart(_inst/APB_S0 0x00008000 1K 0x000083FF 0x000083FF
0x00003400

gpio0_inst/APB_S0
0x000087FF
4 3

Figure 2.74. Address View

2. (Optional) Set or clear the Lock options as desired in Address view.

3. (Optional) Double-click the base address in Address view (Figure 2.75). Type the new value and press Enter. Values
must align with 1K boundaries, such as 0x00000400, 0x00000800, or 0x00000C00. The end address value changes
based on the new value. The Lock option is selected automatically at this time.

Schematic Address A, Start Page
Cell Base Address Range End Address Lock
~ cpul_inst
™ LocalMemory OxFFFFO000
cpul_inst/pic_timer_registers 2K OxFFFFOTFF

> cpul_inst/AHBL_MO_INSTR(32 address bits: 4G)
sysmem0_inst/AHBL_SO 0x00000000 32K 0x00007FFF

* cpul_inst/AHBL_M1_DATA(32 address bits: 43G)

gpiol_inst/APE_SO 0x00008400 1K 0x000087FF
sysmem0_inst/AHBL_S1 0x00000000 32K 0%00007FFF
uart0_inst/AFB_SO 0x00008000 1K 0x000083FF
0xFFFFO7FF
4 »

Figure 2.75. Edit Base Address
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Note: If there is a conflict of a related address space, it is shown in red in the graphic.

2.2.12. Validating the Design

The design rule check (DRC) can be run at any time. This checks whether or not there is any illegal connection or
overlapping address space.

To perform the design rule check:

]

1. From the toolbar of the Propel Builder main window, click the Validate Design icon TQ . The DRC results appear in

the Tcl Console.

2.2.13. Generating the RTL file

The final step for creating a Propel Builder module is to generate a .sbx file, which defines a Propel Builder project, an
RTL file, and the instantiation templates. The RTL file includes the Verilog code for the module. The instantiation
templates have Verilog and VHDL code to help instantiate the Propel Builder module in a design.

e  From the toolbar of the Propel Builder main window, click the Generate icon 1 . This step also saves the Propel
Builder design and runs the design rules check (DRC).

e  From the toolbar of the Propel Builder main window, click the Generate Memory Report icon . The SoC
design memory information is generated. The memory report folder (mem_report) is generated. All design
memory information is shown in detail in the memory report files. The Memory Report files are in HTML format
(Figure 2.76).

50C Memory Map for SOC : Project Summary Page
HelloWorld Generated by Lattice Propel Software SOC Verification Engine

Copyright (C) 1992-2021 Lattice Semiconductor Corporation. All Rights Reserved.
Table of Contents

Project Summary

Project Name Family Device PartName Langunage

HelloWorld LFCPNX LFCPNX-100 LFCENX-100-9LFG672C

ml

Figure 2.76. Memory Report

2.2.14. Opening Project in Diamond or Radiant

In a complete SoC project, a Diamond or Radiant project can be created including a Propel Builder design, and after
that the SoC project can be opened in Diamond or Radiant software. According to device in the SoC project, Propel
Builder can launch Diamond or Radiant software accordingly. If the device is LCMX0O3D, MachXO3L, MachXO3LF,

’
MachX02, LFMNX, the Diamond icon is shown in the Builder GUI Toolbar. If the device is LIFCL, LFD2NX, LFCPNX,

and LFMXQO5, the Radiant icon is shown in the Builder GUI Toolbar. For a template SoC project, you can launch
Diamond or Radiant software directly after template SoC project is created.

e To launch Diamond software:

a. Click the Diamond icon from the Propel Builder toolbar.

b. Lattice Diamond is launched with a Diamond project generated for SoC at background (Figure 2.77).

www.latticesemi.com/legal


http://www.latticesemi.com/legal

::LATTICE Lattice Propel 2022.1 Builder

User Guide
* Lattice Diamond - Start Page - o X
File Edit View Project Design Process Tools Window Help
P-rE-Ha8 rayhh eEBAGAdS BE:E B
PECEECEGDEEGA=USSoVESY FEREHE @
File List & % ([ start Page ) & x
~ [} Sentry
LCMX03D-8400HC-6BGA84C .
- i3 Strat. Project: Release Notes FPGA Design Guide
rategies
= Ag [ Open... Lattice Dimond Software 3.12 SP1 Release Notes  Design Planning
[ Area )
[ /0 Assistant e User Guides HDL Coding Guidelines
B Quick I3 Import ispLEVER Project... Lattice Diamond 3.12 User Guide Timing Closure
[ Timing Recent Projects: Lattice Synthesis Engine for Diamond User Guide  Other Tool Guides
Strategy1 7 sentry Lattice Diamond 3.12 Platform Designer User Guide  ModelSim Users Manual
v [ impt it Clarity Designer User Guide ModelSim GUI Reference Manual
¥ | InputFiles = 2 Lattice Diamond 3.12 Programming Tools User Guid ModelSim Command Reference Manual
i Sentry/Sentry Top.u Reveal User Guide ModelSim Tutorial
M Sentry/Sentry.w [3 MachX030_template02 Reves! Troubleshosting Guid S ymalify Pro User Guid
W Sentry/lib/lstticesemi.com/ip/cpud/2.1.0/rtl/cpully cveal Troubleshosting Gulde YnRity Pro User sulse
X3 Sentry/lib/latticesemi.com/ip/qpio0/16.0/rtl/gpiol.y Lattice Dismond 3.12 Installation Guide for Windows Synplify Pro Reference Manual
Lattice Diamond 3.12 Installation Guide for Linux Synplify Pro Language Support Reference Manual
Wi Sentry/lib/latticesemi.com/ip/sysmem0/1.0.3/rtl/sysmem0.y
M3 Sentry/lib/latticesemi.com/ip/uartd/1.3.0/rtl/uart0.v Reference Guides Tel/ Tk
¥ Sentry/libflatticesemi.com/module/ahbl0/1.3.0/rtl/ahblD.v Diamend 3.12 FPGA Libraries (HTHL version) Lattice on the Web
¥y Sentry/lib/latticesemi.com/module/ahbi2aph0/1.1.0/rtl/zhbl2apb0.v Diamond 3.12 FPGA Libraries (PDF version) Lattice Semiconductor
¥ Sentry/libflatticesemi.com/module/apb0r1.1.0/rtl/apb0y Software Update Center Anewer Databace
Synthesis Constraint Files Currenty runring Lattice Diamond softw, Help
- LPF Constraint Files S12.139 Lattice Diamond 3.12 Help (HTML version) Lattice Solutions
FY Sentrylpf No updates available Lattice Diamend 3.12 Help (PDF Version) Intellectual Property
Debug Files Last check time: Tue Oct 12 16:35:53 20| Tutorials
Script Files Lattice Diamond 3.12 Tuterial
Analysis Files Lattice Synthesis Engine Tuterial
Programming Files
< > < >
Fielst Process Hierarchy
Td Cons & X Output 8 X
> source "C:||Starting: “"source "C:/lscc/propel/2.1/workspace/Sentry/diamond_setup_template.tcl™
>
Starting: parse design source files
(VERI-1482) Rnalyzing Verilog file 'C:/lscc/diamond/3.12/ispipga/userware/NI/SYNTHESIS_HEADERS/ v
Done: design load finished with (0) errors, and (0) warnings
Starting: parse design source files
(VERI-1482) Analyzing Verilog file 'C:/lscc/diamond/3.12/ispfpga/userware/NT/SYNTHESIS_HEADERS/machxo3d.v'
(VFRI_148 il e 1 LElWa] 'l 1 3! T 1 hd
< >| Output Erer  Waming™  Info=
Ready Mem Usage: 170,660 K

Figure 2.77. Diamond Project

c. (Optional) From the File List view of Diamond:
e modify the top-level RTL file (<proj_name>_Top.v) to match the SoC design, presupposition of which is
that there is a top-level RTL file in your SoC design.
e create a top-level RTL file (<proj_name>_Top.v) to match the SoC design, if the SoC design is created from
an Empty Project template and there is no top-level RTL file in your SoC design.
d. (Optional) Modify LPF constraint file (<proj_name>.Ipf) to match the SoC design, if you have modified the SoC
design. This step is a must to the SoC design that is created from Empty Project template.

e. Switch to Process view of the Diamond project (Figure 2.78). Make sure at least one programming file (IBIS
Model, Verilog Simulation File, VHDL Simulation File, Bitstream File, or JEDEC file) is selected in the Export
Files section. Available programming files can be different upon specific device included.
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Figure 2.78. Generate Programming Files

f.  Right-click Export Files, and choose Run

used in the Diamond Programmer.

. The programming file is generated. The programming file can be

Note: Refer to the Diamond online help for more details of the Diamond project. Re-launch the Diamond project,
if the project settings are modified in Propel 2022.1 Builder.

To launch Radiant software:

a. Click the Radiant icon

from the Propel Builder toolbar.

b. Lattice Radiant is launched with a Radiant project generated for SoC at background
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Figure 2.79. Radiant Project

c. (Optional) From the File List view of Radiant:
e modify the top-level RTL file (<proj_name>_Top.v) to match the SoC design, presupposition of which is
that there is a top-level RTL file in your SoC design; or
e create a top-level RTL file (<proj_name>_Top.v) to match the SoC design, if the SoC design is created from
an Empty Project template and there is no top-level RTL file in your SoC design.

d. (Optional) Modify pdc constraint file (<proj_name>.pdc) to match the SoC design, if you have modified the SoC
design. This step is a must to the SoC design that is created from Empty Project template.

e. Click Run all. The Programming file is generated. It can be used in the Radiant Programmer.
Notes:

e Refer to the Radiant online help for more details of the Radiant project.

e About ipx based Radiant implementation flow in Propel Builder:

e To enable Radiant constraint propagation flow, the design source files need to be switched from original
HDL files to ipx file when generating the Radiant project.

e |Ipx based Radiant implementation flow is for project created in later than Propel Builder 2022.1. For
project created before Propel Builder 2022.1, use a different method for exporting files. If you want to use
ipx flow in these old projects, open them in P2022.1 and regenerate, then export to Radiant to change
how it is exported to Radiant. (Figure 2.80).
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Figure 2.80. Radiant Project for Project before Propel Builder 2022.1

Builder side. You must avoid IP update (throu
may cause unexpected issues.

2.2.15. Launching SDK

Considering certain IP are available at both Propel and Radiant side, only update ip through ipx in Propel

gh ipx) in Radiant side, otherwise, the potential out of sync

After a SoC design is completed, Propel SDK can be launched in Propel Builder for software development. For template
SoC project, you can launch SDK directly by clicking Run Propel icon from Propel Builder toolbar after template SoC

project created.

1. Click the Run Propelicon ~~ from the Propel Builder GUI Toolbar. Lattice Propel Launcher (Figure 2.81) opens.

S Lattice Propel Launcher

Select a directory as workspace

Lattice Propel uses the workspace directory to store its

X

preferences and development artifacts,

Workspace: ¢

Browse...

[[]Use this as the default and do not ask again
» Recent Workspaces

Cancel

Figure 2.81. Lattice Propel Launcher Wizard
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2. Click Launch. Propel SDK GUI opens and the C Project wizard (Figure 2.82) pops up for loading the system and the
board support package (BSP) to create a C/C++ project. Enter a project name in the Project Name field, such as

HelloWorld_C. Click Next.

01 C/C++ Project O
Load System and BSP
Correct system environment file and get toolchain parameter
Select system environment file and B5P package
Systern env: | Cflscc/workspace/HelloWorld/HelloWorld/../sge/sys_envaxml - Browse...
Select processor core to create C/C++ Project
Core selected: | cpul_inst
Projecttypes | C
System information
Device Family CPU Mame Instance Mame
LFD2MX fiscv_mc cpul_inst
Project name: | HelloWorld_C
Use default location
Location: | Chlscc\propelh2022. 1\ workspaceh\HelloWorld_C Browse...
Choose file systerm: | default
® < Back Finish Cancel

Figure 2.82. Propel SDK GUI and C/C++ Project Wizard

3. Click Next. The C/C++ project dialog (Figure 2.83) opens.
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ﬁ C/C++ Project

Lattice Toolchain Setting

Configuration: | Debug

Lib Setting  C/C++ Compiler C/C++ Linker

i) Mo default libraries (-nodefaultlibs)

(D) Newlib

() Mewlib-nano (--specs=nano.specs)

(®) Picolibc (--specs=picolibc.specs)

Printf Level

(®) Integer only printf (-DPICOLIBC_INTEGER_PRINTF_SCANF)
() Float printf (-DPICOLIBC_FLOAT_PRINTF_SCAMNF)
() Full printf (-DPICOLIBC_DOUBLE_PRIMNTF_SCANF)

System Library
i@ Default

() Semihosting (--oslib=semihost)
() Dummyhosting (--oslib=dumrmyhost)

Figure 2.83. Create C/C++ Project

4. Click Finish. The C/C++ project is created and is displayed using the C/C++ perspective. A perspective is a collection
of tool views for a particular purpose. The C/C++ perspective is for creating C/C++ programs.

Note: Refer to Lattice Propel 2022.1 SDK User Guide (FPGA-UG-02176) for more details on how to create a C/C++
project and develop the C/C++ project in Propel SDK.
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2.3. Verification Project Design Flow
2.3.1. Creating a Verification Project

1. Choose File > New Design from the Lattice Propel Builder Menu Bar. The Create System Design wizard opens
(Figure 2.84).

%, Create System Design ot

Design Information
Enter a name for your design and specdify a directory where the design files wil be stored.

Project:

Type: SolC Verification -

Mame: Verification_Project

Location: | C:flsccfwaorkspace * | | Browse...

Create Project at C: lscc/workspace Verification_Project

Mext = Cancel

Figure 2.84. Create System Design — Design Information Wizard

Choose SoC Verification from the Type field.

Enter a project name in the Name field, such as Verification_Project.

(Optional) Use the “Browse...” option to change the project location in the Location field, if needed.
Click Next. The Propel Project Configure wizard is shown as Figure 2.85.

vk v
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4. Create System Design *
Configure Propel Project
Specify a device or board for project.
Language: Device Information:
Systemverilog - Part Mumber: LFCPNX-100-8LFG672C
Logic Cells: 96000
Select SoC Project: LUTs: 79872

- Helloworld.sbx | Browse... Registers: prae
EBR. Blocks: 208
LR.AM: 7

M DSP (18x18 Multiplier); 156
ADC Blocks: 1
PLLs: 4

-
DlLs: 2
PCSs: 2

= AllUs: 1
DPHYs: 0
PIO Cells: 299

-
PIC Pins: 359

Template Info:
< Back Mext = Cancel

Figure 2.85. Create System Design — Propel Project Configure Wizard

6. (Optional) The default Hardware Description Language (HDL) is displayed in the Language area. Use the drop-down
menu to change the default language.

Select an existing SBX design by using Browse... to choose an SBX file, such as HelloWorld.
Click Next. The Project Information wizard opens.

Click Finish. A dut_inst of SoC project can be seen in the Schematic view (Figure 2.86).
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Type: Instance

Path: Verification_Project/dut_inst \ '
e S o e ——————

1P Catalog Design View a v
Tel Console [u]

% sbp_desion new -name Verification Projsct -path {Ci/lscc/workspacs/Verification Project/Verification Project.sbx} -device {LFCENX-100-SLFGE72C} -spesd
{9_High-Performance 1.0V}

% sbp_add_sbxcomp -name dut -path {C:/1scc/workspace/HelloWorld/HelloWorld/HelloWorld. sbx}

%

Figure 2.86. Verification Project

Note: The default instance name of an imported Design Under Test (DUT) is dut_inst. By default, its boundary is shown
with dotted line, and the filled-in color is gray. If there is any change in the SOC design, the dut_inst DUT block can be
updated accordingly by double-clicking this dut_inst DUT block, or by right-clicking this dut_inst DUT block and
choosing Reconfig.

ry
[,
10. Click the plus sign l-!-l of this dut_inst DUT block. You can see the whole SoC Design (Figure 2.87). Click the
r=
negative sign 1 to close the expanded bus.

= ‘cpul_inst .
— = sysmemd_inst
ahbio_inst
S04BL_MD, A
—e T FF AHBL_SD

i
— FFIRQ_SIHEL M1 DATAZ FRAHBLSOD -
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T S ) INT_MOgE
i o c s
- i

Figure 2.87. Whole SoC Design

2.3.2. Switching SoC Project to Verification Project
Propel Builder supports switching SoC project to verification project manually after creating a SoC project

1. Create a SoC Project, such as HelloWorld project. Refer to the Creating Template SoC Project section for more
details.

© 2022 Lattice Semiconductor Corp. All Lattice trademarks, registered trademarks, patents, and disclaimers are as listed at www.latticesemi.com/legal.
All other brand or product names are trademarks or registered trademarks of their respective holders. The specifications and information herein are subject to change without notice.

FPGA-UG-02177-1.0 67


http://www.latticesemi.com/legal

Lattice Propel 2022.1 Builder
User Guide

mLATTICE

Note: Corresponding Verification project is created automatically when creating a new empty SOC project. Hello World

Templates can have pre-developed Verification projects.

2. Click Switch Verification and Soc Design icon
opens (Figure 2.88), if a project is not saved.

from Propel Builder GUI Toolbar. Propel Builder dialog box

. Propel Builder

Yes Mo Cancel

0 Save changes made to HelloWorld before opening another systern design?

x

Figure 2.88. Propel Builder Dialog Box

3. Click Yes in the Propel Builder dialog box. The Propel Builder GUI switches to verify the project (Figure 2.89).

. Propel Builder [C:/lscc/workspace/HelloWorld/verification/HelloWorld_v.sbx] Device: LFCPNX-100-SLFGE72C Board: NA

File Edit View Design Jools Window Help

fou = = v
sEHR 9OC FEEWesBB QQQQ
Design View a Schematic Address . Start Page
£} LFCPNX-100-9LFGET2C
» 1} HelloWorld_v
> . Components

sysclk_rst_geni_inst uart_modell_inst

, dut_rst_of— uart_rx_data_debug
bl dut_rst_i th_ck o uart_tx_data_debug
dut_chk_i dut_clk_t Ik uart_rx_break_debug

th_rst_ rstn vart_rx_vald_debug
—— uart_rxd uart_tx_busy_debug
uart_tx_en_debug

uart_txd

Properties

Name:

Type: Instance
Path:  Heloworid_v

VLNV: Iattice:systembuilder:HelloWorld_v:1.0

Fle:  Cifisce y _v.sbuc

1P Catalog Design View a
Tel Console

% sbp design open -name HelloWorld v -path {C:/lscc/workspace/HelloWorld/verification/HelloWorld v.sbx}
%

dut_inst

Figure 2.89. Switching to Project Verification

Note: If the SoC project needs to be re-configured, click Switch Verification and Soc Design

verification project to the SoC project.

2.3.3. Opening a Verification Project

Refer to the Opening a SoC Existing Project section for procedure in detail.

again to switch the
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2.3.4. Adding Modules, IP and VIPs

Refer to the Adding Modules section for procedure in detail.

2.3.5. Working with the Schematic View

Refer to the previous Working with the Schematic View section for procedure in detail.

2.3.6. Connecting Modules

Refer to the previous Connecting Modules section for procedure in detail.

2.3.7. Monitoring DUT

This feature is available to a SOC Verification project only. In Propel Builder, the pin inside DUT can be connected to the
input pin of a VIP. The connected pins can be found at both ends of the orange line, as shown in Figure 2.90. Only pin
and pin bus are supported in the current release of Propel Builder.

!

e

— , : |

Figure 2.90. Monitoring DUT

The testbench generated for this Verification project is shown in Figure 2.91. This testbench file can be used for
simulation.

enl_inst dut clk i1 net;

genl inst dut clk i net = dut_inst.oscO inst.hf clk out o;

clk rst _genl

k_rst_genl inst

Figure 2.91. Testbench of the Verification Project
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2.3.8. Generating Simulation Environment

1.  Click the Generate icon 3 from the Propel Builder Toolbar to generate a testbench file including the scripts for
the chosen simulator, file list for HDLs, and some other files. The testbench file structure is shown in Figure 2.92.

[sim] -- generated simulation environment
[hdl_header]
soc_regs.v -- register definitions of all the components in DUT/SOC
sys_platform.v - base address, user settings of all the components in DUT/SOC
[misc]
* ¥ -- all the mem, hex, txt files will be copied here
flist.f -- file list for HDLs
msim.do -- do script for simulator, it can be gsim for Questasim
wave.do -- do script for adding signals in waveform window
<project_name>.sv -- top testbench, SystemVerilog based

Figure 2.92. Testbench File Structure

Unlike those HDLs generated in the SOC design, the testbench generation in the Verification project is just a start
point for you to work with. Make sure that you generate a new testbench, if there is an existing simulation
environment. A dialog box pops up prompting you to make a choice of Yes or No (Figure 2.93).

4. Propel Builder >

Current simulator has been changed. This operation will overwrite the most
recent simulation result, Do you want to continue?

Yes Mo

Figure 2.93. Propel Builder — A Reminding Dialog Box

2.3.9. Launching Simulation

1. Click Launch Simulation icon from the Propel Builder Toolbar to launch simulation.

2. The default simulation tool, ModelSim, OEM version, opens (Figure 2.94).
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Jrelloworld_vfdu
IHelloWorld_v/dut .
Helloworid_v/du
HelloWorld _vfdut_i... Jooo1
IHelloWorld_v/fdut i... [11111111111111,
Irelloworld_vfdut
HelloWorld_vfdu
IHelloworld_v/dut i
1000000 ns
Pl | | 0,00000 rs
i orary B Memory st | & sim A | | B L Jd L
4 Transaript e
# “* Warning: (vsim-3722) HelloWorld v.sv(104): [TFMPC] - Missing connection for port 'led o'.
# ** Warning: (vsim-2685) [TFMPC] - Too few port connections for 'cpul_inst'. Expected 28, und 27
#  Time: 0 £s Iteration: 0 Instance: /HelloWorld v/dut_inst/cpud_inst File: ../../BelloWorld/HelloWorld.v Line: 1261
b *+ Warning: (veim3722) ..,../HelloWorld/HelloWorld.v(12€1): [TFMPC] — Missing eomnection for port 'timer irg of
# *+ Warning: (veim-3015) [PCDEC] - Port size (<protected>) does mot match comnection size ») for > >
#  Time: 0 fs Iteration: 0 Protected: /HelloWorld v/dut_inst/pll0_inst/lscc_pll_inst/gen no_refclk mon/u_PLL/PLL inst/<protected> File: /home/rel/ng3_1.153/rtf/cac_library/simulation/verilog/controlpack_cre/lfcpnx
/PLL_CORE.v Line: 196
# ©4 Warning: (vsim-2635) [TFMEC] - Too few port conmections for 'sysclk rst_genl inst'. Expected &, found 4.
#  Time: 0 fs Iteration: 0 Instance: /HelloWorld v/sysclk rst_genl inst File: HelloWorld v.sv Line: 117
Now: 1ms Delta: 2 relovorld_/dut instjrxd i

ol [ |

=l
4

Figure 2.94. Simulation GUI

Note: Before launching simulation, you can change Simulator to Questasim by clicking Design > Options from the
Builder Menu bar. Builder Options Wizard opens (Figure 2.95). Click Directories to set a desired Questasim
Location.
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%, Options

Themes: Light

IP TOOL

C:fUsersfUser PropellPLocal
Radiant Location

General Color Metwork Settings Directories

IP Install Path: B Move IPs to new location

Questasim Location

oK Cancel

Set Default

Apply

Figure 2.95. Builder Options Wizard
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2.4. Advanced Usage

2.4.1. Supported Interface

Lattice Propel Builder and IP Packager share the same usage of interfaces. These interfaces are listed below.
e Interrupt

e AMBA3 AHB Lite

e AMBA3 APB

e AMBA4 AXI4

e AMBA4 AXI4 Lite

e AMBA4 AXI4 Stream

e Localbus

Refer to the IP Packager section for detailed usage of these interfaces in the IP Packager.

2.4.2. Supported Language

Propel 2022.1 Builder supports the following languages:
e Verilog HDL

e SystemVerilog

e VHDL

e  Mixed Verilog/VHDL

Currently, verification projects only support Verilog HDL.

2.4.3. Supported Hierarchical IP

Hierarchical IP instantiates a hierarchical component that contains a reference to a design along with a description of
the top-level interface of the component.

Click Expand IP sign on the left corner of the hierarchical IP (Figure 2.96) to show the detailed design scope of this
IP (Figure 2.97).

axilx3_inst
_______________________ \
T '
' I
I —_— —_—
= |=fm] AXI_S00 AXIL_MO1 | b
LI Lr :
|
rs
—ck i AXI_MOO| ||—
| L I
|
rstn_i AXI_MO2 ] e
L (L

Figure 2.96. Hierarchical IP
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axilx3_inst
e T \1
: axizaxil_MO1_inst !
i i '
|
| ryl
AXI_S00 !
| ok |
| = AXIL_M01
i ck AXIL_MOO ] actS,
| L=d 1
| |
| rst_n |
: |
|
| \ 1
: axi_crossbarNxM_inst |
i r ~ | AXI_M0O
|
AXI_S00 raa 30 T
: Lt:AXLSOO AXI_MO1 L'!'J :
) ’ ) |
ck_il r= reg_slice_MO02_inst )
i clk AXLMDOlj-J - :
rstn_i! ry ry ]
—1
| st n AXI_MO02 L'!'J L'!'J AXI_S00 :
| |
| - J =g
: clk AXLMOOL-!-J |
|
: rst_n :
: |
i \ 1
I |
\ Y

Figure 2.97. Hierarchical IP Scope in Detail

2.4.4. Export Interface

AHB Lite or APB interface ports can be connected to external IP outside of Propel Builder. You must use AHB-Lite or
APB feedthrough modules to hold the address space (when feedthrough module is configured as master) or memory
map (when feedthrough module is configured as slave) information. The interface to be exported should be connected
first to feedthrough, then the other end of the feedthrough can be exported. An example is shown in Figure 2.98.

apb_s0_inst.
apb_m0_inst i} aph_s0_inst_APE_MO_interface
b_m0_inst_APB_S0_interface [ FF APB_S0APB_MOFF APB_S01 i
apb_m0_inst_APB_S0_interface [ FFm_Em APBMODEE apb_s1_inst
. APBMOIFF fe>apb_s1_inst_APB_MO_interface
APE_MOZFF
apb_s2_inst

b_presetn_i
ahbl2apb _0_inst
HF APE_SOAPE_MOH i
e FF APE_SDAPE_MORF apb_s2_inst_APB_MO_interface
ki APB_MOFF|
tn_i

TIMER_IRQ_MOH
i 1rg_sg MER-IRQMOF sys_mem_0_inst
) AHBL_MO_INSTRFF Y ’
ki Tk i o FF AHBL_SO
- _ AHBL_M1_DATAFF| ~
rst_n_i[> Lo i HF AHEBL 51

system_resetn_ ahbl_int inst bl bl s

F AHBL S00  AHEBL_MO1FHF — shbl_hresetn i
C__Lhbl hok i AMBL_MODFF| ahbl_s0_inst

T—am_hssm_i AHEL_MO2FF IFF AHBL_SO .AHBLMOFF'—E>ahbl_sU_\HSt_AHEL_MU_\HtErfEEE

Figure 2.98. Export Interface Example

In the example above, to export interface ahbl_int_inst. AHB_MO02:

1. Instantiate an AHB-Lite feedthrough module from IP catalog, and configure it as slave. The instance name here is
ahbl_sO_inst.

2. Set the address width and data width for the memory map.
3. Connect ahbl_int_inst. AHB_MO2 to ahbl_sO_inst. AHBL_SO.
4. Export ahbl_sO_inst. AHBL_MO for external IP.

You can see the memory map for ahbl_sO_inst is shown in the Address Editor (Figure 2.99).
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Schematic Address % Start Page

Cell
~* apb_m0_inst
v apb_m0_inst/APB_MO(32 address bits: 64K)
apb_s0_inst/APB_S0
apb_s1_inst/APB_S0
aph_s2_inst/APB_S0
~ cpu__inst
* LocalMemory
cpu_0_inst/pic_timer_registers
* cpu_0_inst/AHBL_MO_INSTR(32 address bits: 4G)
sys_mem_0_inst/AHBL_S0
~ cpu_0_inst/AHBL_M1_DATA(32 address bits: 4G)
ahbl_s0_inst/AHBL_S0
apb_s0_inst/APB_S0
apb_s1_inst/APB_S0
apb_s2_inst/APB_S0
sys_mem_0_inst/AHBL_S1

Base Address

000010800
0x00010C00
0x00011000

0xFFFFO000

000010000
000010800
0x00010C00
000011000

Range

1K
1K
2K

2K

64K

2K
1K
1K
2K
64K

End Address

0x00010BFF
0x00010FFF
0x000117FF

O0xFFFFOTFF

0x0000FFFF

0x000107FF
0x00010BFF
0x00010FFF
0x000117FF
0x0000FFFF

Figure 2.99. Memory Map for ahbl_s0_inst in Address Editor

2.4.5. Define Custom Template

Lock

Saving design as template is an enhancement feature of Propel Builder, which allows you to create your own new
project template based on existing design. You can deploy this template into Propel Builder later or share it with others
by saving template into a .ptmp file. See below on how to make a .ptmp file)

This function takes effect from Propel Builder 2022.1, so the design created in earlier Propel Builder versions cannot

define its custom template.

e  Export current template configuration:

Choose Tools > Create Template from Propel Builder Menu Bar. Template Configuration (Figure 2.100) opens.
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4, Template Configuration

General
Mame: Hello World Preject_1 Processor: RISC-W MC
[] RISC-V SM

Vendar: Latticesemi [ RISC-V RX
Version: 1.0
Board Only: Deseaription: 1o nlate description
Device Family: [ LAV-AT -

LFCPMX

[ LFD2MX

[ LFMX05

[ urcL

[ LFMMX

] MachxQz2

[0 Machx03D
Supported Boards

Mame Version Partiame Speed

1 CertusPro-NX Evaluation A LFCPMNX-100-9LFGE72C | 9_High-Performance_1.0¥

2

Add
Template Resources
1 [ /HelloWorld/application
Share Template
C:fUsers fizheng fwerwre. ptmp
Generate

Figure 2.100. Export Template Configuration Page

a. Fillin general information such as Template name, Description, Vendor.

b. Select Processor, Device Family, and Supported Boards:

e The device used in the current design is listed by default. You must make sure the design can work on all

the devices in the list.
e How:

e Click on IP instance in Schematic view, the Design View shows the corresponding information of this IP.

Check VLNV for this IP name (Figure 2.101). Go to IP Catalog, click on

before this IP to show the IP

Information. In Device Supported area, all the devices this IP supports are listed (Figure 2.102). Make
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sure all the IP instances in the design have the device support which are listed in the Board Family list in
Template Configuration (Figure 2.100).

Design View o Schematic Address & stert Page
B LFCPNX-100-9LFGET2C A

~ ZE HelloWorld
v ¥ Instances

» i ahbi0inst
v L testinst
» % apblinst
> {F cpu_inst
» 1 equation_moduled_inst
» % gpiolinst
» I osclinst

~ i test pllinst =yEmend ot

- & Ports

© dii Nopmuy

I dkop_o

o diono Pul_inst. ahblo_inst

@ lock o #9051 AL MO_INSTR | tam e

© o o o et = — | r
b £ spsmembnst ] o [ !

v I vart inst i

» S pons

b Nets

b Componers [

e,

g0t

sea e

Properties
Name: | test pil_inst

Type: Instance
Path: _HeloWorid/test pl inst
VLNV latticesem, com:module:pl0:1.7.0

Design view P Catabg g >

Figure 2.101. Check IP Name in Design View

% Propel Builder [D: p/wspace ¢ sbx] Device: LFCPNX-100-9LFG672C Board: CertusPro-NX Evaluation(4) - X

File Edit View Design Tools Window Help

sE2A 9D C S MEE NS @A o QQ Q@

1P Catalog o Schematic Address . startpage
o & i

P onlocal 1P on Server v
L Module/IP on Local A
~ Module

v (7] Architecture Modules:

% 05C 140
@ ® pLL 170

e Subfractor 140
3 Comparater 140
& Complex_Mult 150
B Convert 140
& Counter 140
PR 140 — —
 Mukt Aceumulate 150
4 Mult Add Sub 150
5 Mult Add Sub Sum 150
T Muttiplier 140
5 Sin_Cos Table 130
% subtractor 140

» ) Memory Modules

I ——— (a0

120 con e -

N ! |
- |

» [ Processors Controllers and_Peripherals
b 3 Verification IP
- P -

fof f= wf  Jas o

l cquation  split concat invert

P Catalog Design view 0 =
IP Information =]

PLL

Description

The Lattice Semiconductor PLL IP implements a Phase Locked Loop

Devices Supported
LIFCL-40, LIFCL-33, LIFCL-17, LFD2NX-40, LFD2NX-17, LFCPNX-100, LFMXO05-25, UT24C40, UT24CP100

References

Td Console IP Information

Figure 2.102. Check Device Supported in IP Information

e You can add the board information manually in Supported Boards (refer to Figure 2.4 for board
information) and you must ensure the correctness of the board information and the design can work on
this board.

c. Template Resources:
e  Optional resources include the newly created project such as C application project, user RTLs.
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d. Output:
e By default, after you click the Generate button, the new template can be installed to your custom
template folder, which is a folder named PropelTemplateLocal under SHOME (Figure 2.103).

| [+ = | Latticesemi_MNew_Hello_World_1_1.0

Home Share View

€« v » ThisPC » Windows (C) » Users » jzheng » PropelTemnplatelocal » Latticesemi_Mew_Hello_World_1_1.0 v
MName Date modified Type Size
7 Quick access
application 10/12/20. File folder
@ OneDrive lib 1012/ File folder
I This PC verification 10/12/. File folder
. || New_Hello_Waorld_1.psc 10/12/20, PSCFile 1KB
) 30 Objects P . —
|| New_Hello_World_1.tcl 10/12/20. TCL File 5 KB
I Desktop | New_Hello_World_1.&xt 10/12/20 Text Document 1KB

|5 Documents

Figure 2.103. Export Template to PropelTemplateLocal Folder

e If you want to share this template, you can click Share Template and output this template to a .ptmp file
which can be later installed to Propel Builder by other people.

e Template manager page for custom templates:

You can import/delete/export a selected template in Template Manager when creating a new system design
(Figure 2.104 and Figure 2.105).

. Create System Design

Configure Propel Project
Specify a device or board for project.

Language: Device Information:
: Part Mumber: LAV-AT-500L-1LFG1156C
Verilog -
Logic Cells: 477000
Family: Board Processor: LUTs: 397440
LAV-AT - RISC-V MC - Registers: 397440
EBR Blocks: 930
Device: Templates:
: DDRPHY: 3
LAV-AT-500L +  Empty Project DSPs: 1800
Helle World Project
Package: PLLs: 11
LFG1156 - DLLs: 3
PCSs: 0
St PIOCels: 567
1 4 PIO Pins: 567
Operating Condition:
Commerdial A
Template Info:
Empty project for user to "build from scratch™
Online Data Sheet for Device Template Manager
< Back Next = Cancel

Figure 2.104. Template Manager Entry
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4. Systemn Builder

Templates Manager:
Name

Vendor Version Family Processor
1 Hello_World_Project_1 Latticesemi 1.0 LFD2MNX RISC-V MC
2 Helle_World_Project_1 Latticesemni 1.1 LFD2MNX

3  Lattice_Sentry_ReT _Project_1 Latticesemi 1.0 MachX03D RISC-V MC

Import Delete Export

RISC-V MC:RISC-Y SM;RISC-V RX | Certus-MX Versa Evaluation

Board

Certus-MX Versa Evaluation

Mach¥03D PFR. Demeo

Figure 2.105. Templates Manager Page

e Toimport a template, click Import (Figure 2.105), and then choose the desired .ptmp file (Figure 2.106).

“ Import Template Package

&« v » This PC » Desktop » test

Organize v New folder

& OneDrive ~ Name Date modified Type

I3 This PC D 555.ptmp 10/12/2022 8:17 AM PTMP File
— This

_' 3D Objects

[l Desktop

; Downloads

b

=

Documents

Music
Pictures
m Videos
25 Windows (C)
- Mew Volume (D:)

[_} Network
v

w

o

S

O Search test

ize

4,457 KB

File name: | S55.ptmp

v| Ptmp file (*.ptmp) ~

Cancel

Figure 2.106. Import ptmp File

e Custom template installation path:

Custom templates are installed in SHOME/PropelTemplateLocal directory by default (Figure 2.107).
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4., Options >
Themes; Light -
General Colar Metwork Settings Directories
IP TOOL
IF Install Path: Move IPs to new location

C:/Usersfizheng /PropellPLocal

Tempaltes
Tempaltes Install Path: Move tempaltes to new location

C:/Usersfizheng /PropeTemplatelocal
Radiant Location
C:/lscofradiant/2022. 1

Diameond Location
C:flscc/diamondf3. 12

Questasim Location

Set Default

QK Cancel Apply

Figure 2.107. Template Manager Page

You can move it to another location in Options page (Figure 2.108).
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4. Options >
Themes: Light -
General Colar MNetwork Settings Directories
IP TOOL
IP Install Path: Mave IPs to new location

C:/Usersfizheng/PropellPLocal

Tempaltes
Tempaltes Install Path: Maove tempaltes to new location

C:/Usersfjizheng/PropelTemplateMew
Radiant Location
C:lsccfradiant/2022. 1

Diamond Location
C:lscc/diamond/3, 12

Questasim Location

Set Default

K Cancel Apply

Figure 2.108. Template Manager Page — Change to New Location
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2.4.6. Include Sub Sbx File

Right Click on Schematic View and choose Add Sbx Instance (Figure 2.109), and then chose the sbx file you want to

input (Figure 2.110).

Create Port
Add Shx Instance

[
Auto Connect i

Create Comment
3 Validate Design

Select All
Relayout

Figure 2.109. Right Click on Schematic View

%, Add Sbx Instance *

Instance Name:
Shx File Path:

oK Cancel

Figure 2.110. Input sbx File and Instance Name
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3. IP Packager
IP Packager is a tool for you to create an IP package easily. You can edit port, file, parameter, and memory in the IP
Packager, and pack a customized IP directly.

IP Package is a collection of all required files related to an IP. All the related files are organized in different directories
(Figure 3.1).

- [IP Package]
- metadata.xml
- [rtl]
- [testbench]
- [1ldc]
- constraint.ldc
- [driver]
- [ip_eval]
- [plugin]
- plugin.py
- [doc]
- introduction.html
- EULA.tXxt

Figure 3.1. Example Directories and Files of an IP Package

e metadata.xml [mandatory]: XML metadata file which mainly describes legal usage and interface of an IP.

e rtl [mandatory]: Directory for parameterized HDL source files. HDL source files contain configurable parameters for
you to configure.

e testbench [optional]: Directory for test bench files.
e |dc [optional]: Directory template constraint file. The file name should be constraint.ldc.
e driver [optional]: Directory for driver source code files.

e plugin [optional]: Directory for Python script to implement internal logic of the soft IP. The file name of Python
script should be plugin.py.

e doc[mandatory]: Directory for documentation files. It should contain one mandatory introduction file, one
mandatory license agreement file, and other optional documents.

The custom IP package can be used in Propel Builder for SoC design. IP instance package (Figure 3.2) is generated when
user configures IP in Propel Builder.

- <instance name>

- <instance name>.cfg

- <instance name>.ipx

- component.xml

- design.xml

- [rtl]
- <instance name>.v
- <instance name> bb.v

- [constraints]
- <instance name>.ldc

- [driver]

- [ip_eval]

- [misc]
- <instance name> tmpl.v
- <instance name> tmpl.vhd

Figure 3.2. Example Directories and Files of an IP Instance Package

www.latticesemi.com/legal


http://www.latticesemi.com/legal

Lattice Propel 2022.1 Builder ...... L ATTICE

User Guide BN sEMICONDUCTOR,

3.1. Launching IP Packager

1. Choose Tools > ¢ IP Packager from the Lattice Propel Builder Menu Bar.

Note: You can also launch IP Packager from Radiant 3.2 or later version if you have already installed Radiant. To
launch IP Packager, you can go to the Windows Start menu and choose Programs > Lattice Radiant Software >
Accessories > IP Packager.

2. IP Packager is launched (Figure 3.3).

™ 1P Packager — [m] K

File Edit Help

@D

Figure 3.3. IP Packager GUI

3.2. Packing Custom IP Flow

3.2.1. Opening an IP Directory

1. Choose File > Open IP Directory from the Propel Builder Menu or Click the Open Design icon from
Propel Builder Toolbar. The Select Folder dialog opens (Figure 3.4).
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™) Select Folder *
« v <« workspace * |Ps » gpio » v | D £ Search gpic
Organize - Mew folder Bz ~ e
doc - MName Date modified Type
lemb doc 10/13/2021 1:28 PM File folder
& OneDrive driver 10/13/2021 1:28 PM File folder
plugin 101372021 1:28 PM File folder
[ This PC rtl 10/13/2021 1:28 PM File folder
_J 30 Objects testbench 10/13/2021 1:28 PM File folder
B Desktop
Documents
* Downloads
J‘ﬁ Music
&1 Pictures v £ >
Folder: | gpic
Select Folder Cancel

Figure 3.4. Select Folder Dialog

Choose a desired IP directory.

Click Select Folder. The IP Packager GUI shows the IP Package project (Figure 3.5). IP package project includes three
mandatory parts (Meta Data, Design File, and Doc) and two optional parts (Test Bench and Misc) that need to be
edited. Refer to the Editing IP section for more details.
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*1p Packager - C:/Users/jzheng/PropellPLocal/latticesemi.com_ip_gpio_1.6.1 — O =
File Edit Help
= +
=
Project Meta Data
Met.a Dai.:a Besidin) VLNV General Information
Design Files ~ Parameters
Test Bench v Vendor: latticesemi.com Type: Optional
Misc
Dac Assistant M 'iortr: N Library: ip Category: Processors_Controllers_and_Peripherals
y O OUT Mame: gpio Keywords: BusType_APBE
>
@ INouT IP version:  1.6.1 Display name: GPIO
¥ Interfaces
APB S0 Minimal Radiant ion: 2022.1
lNTR Suppor(ed e Family - inimal Radiant version:
* Memory Ma Maximum Radiant version: | Optional
.ry P Any Device
b gpio_mem_map
Minimal Propel version: 20221
LAV-AT
Maximum Propel version: | Optional
LFCPNX
Supported platform: Radiant Propel
LFD2NX Instantiate Once:
LFMX035
LIFCL
LFMMX
MachX02
hAarh¥Man d
Application Output }_1 >
set ip directory: C:/Users/jzheng/PropellPLocal/latticesemi.com ip gpio_l1.6.1 -
load existing ipk project from C:/Users/jzheng/PropelIPLocal/latticesemi.com ip gpio_1.6.1
-
Output

Figure 3.5. IP Packager with IP Project Details

Note: If you prepared all directories and files of an IP module in advance, the IP Packager can load the information. If
you do not want to update the IP module information, you can skip the Editing IP section below.
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3.2.2. EditingIP

1. From the IP Packager Project area, click Mata Data. The IP Packager GUI shows Meta Data information in detail
(Figure 3.6).

] IP Packager - C:/Users/jzheng/PropellPLocal/latticesemi.com_ip_gpio_1.6.1 - O *

File Edit Help

& [

Project Meta Data
Met.,a Dai.:,a Basic Info VLMY General Information
Design Files ~ Parameters
Test Bench v Ifl Vendor: latticesemi.com Type: Optional
Misc * Ports . . i
Dac Assistant R Library: ip Category: Processors_Controllers_and_Peripherals
» 1 ouT Name: gpio Keywords: BusType_APB
3
© Nnout IP version:  1.6.1 Display name: GPIO
¥ Interfaces
ﬁ;p%so Supported Device Family «  Minimal Radiant version: 20221
* Memory Ma . Maximum Radiant version: | Optional
ryap [ Any Device
b gpio_mem_map
Minimal Propel version: 20221
LAV-AT
Maximum Propel version: Optional
LFCPNX
Supported platform: Radiant Propel
LFDZNX Instantiate Once:
LFMXO5
LIFCL
LFMN
MachX02
Markh¥ 02N -
Application Output é_-| X
set ip directory: C:/Users/jzheng/PropellPLocal/latticesemi.com ip gpio_l1.6.1 =
load existing ipk project from C:/Users/jzheng/PropellPLocal/latticesemi.com ip gpio_1.6.1
-
Output

Figure 3.6. IP Packager with Meta Data Details

a. To configure basic information:
e  C(Click Basic Info from Meta Data view (Figure 3.7).
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mLATTICE

Meta Data

:Basic Info

Parameters

3

Ports

o IN

PO OUT

P INOUT

Interfaces
APB_S0
IMNTR

Mermory Magp

b gpio_mem_map

Figure 3.7. Meta Data View

e You can see the Basic Info properties in detail as shown in Figure 3.8.

Meta Data

Basic Info
~ Parameters

-

3 General

* Ports
P N
r < 0OUT
r O INOUT
Interfaces

APB_S0

INTR
¥ Memory Map

b gpio_mem_map

4

VLMW

Vendor: latticesemi.com
Library: ip

MName: gpio

IP version: | 1.6.1

Supported Device Family
Any Device

LAV-AT

LFCPNX

LFD2MNX

LFMX 05

LIFCL

LFMMX

MachX02

LY EP N {akin]

General Information
Type:

Category:
Keywords:

Display name:

Minimal Radiant version:

Maximum Radiant version:

Minimal Propel version:

Maximum Propel version:

Supported platform:
Instantiate Once:

Optional
Processors_Controllers_and_Peripherals
BusType_AFPE

GPIO

2022.1

Optional

2022.1

Optional

Radiant Propel

Figure 3.8. Configure Basic Info

e Configure the basic information by entering desired value for a property or checking the checkbox for the
property in the property field. For example, click the Vendor filed to enter a desired vendor value.

Note: IP Packager supports both Radiant and Propel software. IP Packager currently is based on Radiant
2022.1 but does not support Radiant version of which is lower than 2022.1. “Minimal Radiant version”
should be set to 2022.1 or 2022.1 +. For Propel, IP Packager currently is based on Propel 2022.1, not
support Propel version of which is lower than 2022.1. “Minimal Propel version” should be set to 2022.1 or
2022.1+. If the version of Radiant or Propel is invalid, a warning message is shown (Figure 3.9).
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File

&= [

Project

Meta Data
Design Files
Test Bench
Misc

Doc Assistant

Edit  Help

IP Packager - C:/Users/jzheng/PropellPLocal/latticeserni.com_ip_gpio_1.6.1

Meta Data
Essicinin VLNV General Information
~ Parameters
- Vendor: latticesemi.com Type: Optional
4 General Library: ip Category: Processors_Controllers_and_Peripherals
~ Ports
» [N Mame: gpio Keywords: BusType_APBE
» @ out IP version:  1.6.1 Display name: GPIO
O INOUT
~ Interfaces Supported Device Family 4 Minimal Radiant version: 2.2
APB_SD
Maximum Radiant version: | Optional
M INTRM Any Device E
-
emo.ry 2P Minimal Propel version: 20221
b gpio_mem_map LAV-AT
Maximum Propel version: | Optional
LFCPNX
Supported platform: Radiant Propel
LFD2NX Instantiate Once:
LFMX035
LIFCL
LFMMX
MachX02
hAarh¥Man d

s

Application Output -

set ip directory: C:/Users/jzheng/PropellPLocal/latticesemi.com ip gpio_l1.6.1
load existing ipk project from C:/Users/jzheng/PropelIPLocal/latticesemi.com ip gpio_1.6.1

Output

Figure 3.9. Warning Message of the Invalid Radiant and Propel Version

b. To configure parameters:
Parameters are settings that can be used in Ports/Interfaces/Memory map configuration. You can think of
them as macros. For example, click on Port gpio_i, you can see its configuration. In gpio_i, there is a value

using EXTERNAL_BUF that is defined in Parameters (Figure 3.10).

© 2022 Lattice Semiconductor Corp. All Lattice trademarks, registered trademarks, patents, and disclaimers are as listed at www.latticesemi.com/legal.

All other brand or product names are trademarks or registered trademarks of their respective holders. The specifications and information herein are subject to change without notice.

FPGA-UG-02177-1.0

89


http://www.latticesemi.com/legal

Lattice Propel 2022.1 Builder

User Guide

w2 LATTICE

File Edit

Project

Meta Data
Design Files
Test Bench
Misc

Doc Assistant

Help

Meta Data
Basic Info
~ Parameters

v [ Tabl

- IEI Groupl
FAMILY
10 LINES COUNT

I EXTERNAL BUF I

OUT_RESET_VAL_INPUT
OUT_RESET_VAL
10_OQUT_DEF_VAL
DIRECTION_DEF_VAL_INPUT
DIRECTION_DEF_VAL
DIRECTION_DEF_ENCODING
IF_USER_INTF

= [ Group2

NewParam1

MNewParam2

- [ Tab2
» [ Groupl
~ Ports
* [N
| apio_i ]
clici
resetn_i
Immi_request_i
Irmimi_wr_rdn_i
Immi_offset_i
Immi_wdata_i
apb_penable_i
apb_psel_i
apb_pwrite_i
apb_paddr_i
apb_pwdata_i
» < ouT
v D INOUT
~ Interfaces
APB_S0
INTR

* Memory Map

Property Value
range (I0_LINES_COUNT -1, 0}
conn_pert | gpio_i
conn_range

stick_high

Note:
Click table to change value.

stick_low I EXTERMAL_BUF == False

stick_value
dangling
attribute

port_type

Figure 3.10. Preview on Parameters

e Two-level hierarchy (Tab/Group) is used to categorize the parameters. Click on the IP Preview icon from

the toolbar (Figure 3.11), you can see the hierarchy relations (Figure 3.12).
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File Edit Help

=

Project

Meta Data
Design Files
Test Bench
Misc

Doc Assistant

Meta Data
Basic Info
¥ Parameters

- | Tabl

FAMILY
10_LINES_COUNT
EXTERMAL_BUF
OUT_RESET_VAL_INPUT
OUT_RESET_VAL
10_OUT_DEF_VAL
DIRECTION_DEF_VAL_INPUT
DIRECTION_DEF_VAL
DIRECTION_DEF_ENCODING
IF_USER_INTF

|+ | Group2 1

MNewParam1

MNewParam2
- [0 Tab2
v [ Groupl
~ Ports
> [N
gpio_i
clki
resetn_i
Immi_request_i
Irami_wr_rdn_i
Immi_offset_i
Irmmi_wdata_i
apb_penable_i
apb_psel_i
apb_pwrite_i
apb_paddr_i
apb_pwdata_i
v O ouT
b D INOUT
~ Interfaces
APB_S0
INTR.
* Memory Map

Figure 3.11. Two-Level Hierarchy to Categorize Parameters

Property Value
range (IO_LINES_COUNT - 1, 0)
conn_port  gpio_l
conn_range
stick_high
stick_low EXTERMAL_BUF == False
stick_value
dangling

attribute

port_type

Note:
Click table to change value.
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[ IP Preview b

Configure Component from Module gpio
Version latticesemi.com

Set the following parameters to configure this component.

Diagram ippackager_preview_inst Configure IP
Tab1 I Tab2
Property Value
MNumber of I/0 Lines [1-32] 1
Remove Tri-5tate Buffer O

Initial Output Value (hex) [0 - FFFFFFFF] | 0

ippackager_preview_inst

APB_S0
— INT Interface APB

0 Direction (hex) [0 - FFFFFFFF] 1

. gpIO_IO[OO] NewParam1
reSEtn_l MewParam2
gpio
1 2 Mo DRC issues are found.

Cancel

Figure 3.12. IP Preview Showing Two-level Hierarchy in Parameters

e Naming rules for parameters:
e  Parameters in all groups should not have the same name, which is similar that macro redefinition is not
allowed.
e  Characters support in naming are letters with mixed case, numbers and underscore (_).

e To add a parameter, right-click Parameters from Meta Data view and choose Add Parameter Tab
(Figure 3.13). Tab1 is created under Parameters.
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Meta Data

Basic Info

* iParameters

Add Parameter Tab

o

T 1IN
Interfaces

Mernory M:

Figure 3.13. Right-click Menu of Parameters in the Meta Data View

e Right-click Tabl under Parameters from Meta Data view, and choose Add Parameter Group. Group1 is
newly added under Tab1 (Figure 3.14).

Basic Info
* Parameters

- Tab1
Groupl
* Ports
M
ouT
= INOUT
Interfaces
Mermory Map

Figure 3.14. Group1 Added to Tab1l

e Right-click Group1 under Tab1l from the Meta Data view, and choose Add Parameter. NewParam1 is
newly added under Group1 (Figure 3.15).
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Meta Data
Basic Info
Mote:
* Parameters Property Value Click table to change value.
M title
- General
NewParam‘I type param
~ Ports value_type string
r N
default
v O ouT
» @ INOUT value_expr
* Interfaces .
options
APB_SD
INTR output_formatter

> Memaory Map

» gpio_mem_map bool_value_mapping
editable
hidden

drc

regex
value_range

config_groups

description

Figure 3.15. NewParam1 Added to Groupl

e Double-click NewParam1 to rename the parameter (Figure 3.16). The parameter name is also used as the
unique ID of the parameter setting.

Basic Info
* Parameters

- Tab1

A Group1

* Ports

M

O out

O INOUT
Interfaces
Mernory Map

Figure 3.16. Rename a Parameter

o Double-click the property value field to enter the desired parameter value, or select the desired value
from drop-down menu (Figure 3.17). The properties are thus configured. Property listed in bold must be
configured. The details of each property is shown in Table 3.1.
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= Parameters Property Value Python expression to determine whether
- Tab1 or not the parameter is hidden in GUI.
title Device Architecture
h Group1 Example:
FAMILY type param hidden="True"
~* Ports
N value_type string
out default LIFCL
o INOUT
Interfaces value_expr
M M
emory Vap options

output_formatter
bool_value_mapping

editable

hidden éTrue

drec

regex
wvalue_range
config_groups

description

Figure 3.17. Configure a Parameter

Table 3.1. Details of Parameter Property

Property Value Mandatory Description
title String No Short title of the setting. If “title” is not specified, value of “setting” is used.
Example:
title="Device Architecture”
type param, Yes A setting can be a Verilog parameter, Verilog macro definition or user input.
input, Param, 94olean_macro and input settings can be used to compute values of
command other param and input settings. They only differ in generated files. Param is
written out as a Verilog parameter value of the IP module. 9500lean_macro is
translated to a Verilog macro definition by the define compiler directives, but
input is not. Command shows as a button.
Example:
type="param”
value_type bool, string, Yes Type of the value. Supported types are bool, int, float, string, and path. The
int, float, int type supports unlimited precision.
path The float type supports the precision of float type of C programming language.
Refer to the Characteristics of Floating Types section of the 1999 ISO/IEC C
Standard for details.
The path type indicates a string which represents a path. “/” is used as
separator.
Example:
value_type="string”
default Python No Default value of the setting. If the setting has no “default” attribute but has
expression “options” attribute, the first option is picked as default value. If the setting has
neither “default” attribute nor “options” attribute, the initial value of setting is
set to O for int, 0.0 for float, “” for string and False for bool. By default, it is not
allowed to reference to other setting values. Use value_expr as reference
values.
Example:
default="LIFCL"
value_expr Python No Python expression to compute the value of the setting. The result is used as the
expression parameter value if the setting is not editable. For example, divider is calculated
by frequencies.
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Property Value Mandatory Description
Example:
value_expr="int(round((sys_clock_freq * 250.0) / i2c_left_desired_frequency))-
17
options Python list No Candidate options for the setting, which is used by GUI to display a dropdown
or list of selector. It can be set to a simple list or a list of tuples. If it is a simple list,
tuples elements are displayed and written. Ifitis a list of tuples, the first item in tuple
is displayed and the second item in tuple is written.
Example:
options="[0.1, 0.2, 0.5, 1.0]”
output_forma | str No Control how parameter values are written in output RTL files. Following
tter formatters are supported.
Str: parameter values are written as strings
nostr: quotation marks of strings are removed
Example:
output_formatter="str”
bool_value_ Python tuple | No The map-to-map bool values to dedicated strings. By default, bool values are
mapping or list with 2 written as 1, 0.
string Example:
elements bool_value_mapping="(‘True’, ‘False’)”
editable Python No Python expression to determine if the setting is editable. When a setting is not
expression editable, it is grayed out in GUI display and its value is computed by value_expr.
Otherwise, user input is used.
Example:
editable="(FEEDBACK_PATH == ‘PHASE_AND_DELAY’)
(FEEDBACK_PATH is a setting ID in metadata.xml)
hidden True No Python expression to determine whether or not the setting is hidden in GUI. If
hidden is set to True (default is False), the item is hidden in GUI. The expression
is resolved to 9600lean value after the user setting is changed.
Example:
hidden="True”
drc Python No Python expression to do DRC on the setting. True means DRC pass.
expression Example:
drc="check_valid_addr_pre(12C_LEFT_ADDRESSING_PRE,i2c_left_addressing_wi
dth)”
(check_valid_addr_pre is defined in plugin.py
setting ID: 12C_LEFT_ADDRESSING_PRE
i2c_left_addressing_width
)
regex Regular No Regular expression to do DRC on the value. For example, the value should be
expression prefixed by “0Ob”.
Example:
regex="0b[01]+”
value_range Python tuple | No Valid range of setting value, which is used to do DRC on the setting. The
or list with 2 maximum value can be infinity “float(‘inf’)”.
comparable Example:
elements value_range="(0, 1023) if(i2c_right_enable) else (-9999, 9999)”
config_groups | Python No A name or names to group settings together. It is copied from IP-XACT
expression configGroups attribute, and only supports “SystemBuilder” value. If it is
defined, related RTL parameter is brought out to IP instance top module, so that
System Builder can re-define its value.
Description String No Detailed description of the setting.
Macro_name | id, value No Specify how to name the Verilog macro in ‘verilog_macro’ type setting item, the

ID or value of this setting item. The default value is ‘setting’, which means the
setting’s ID will be defined as a Verilog macro. If it is set as ‘value’, the evaluated
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setting value is the Verilog macro.
Example:

maro_name= “value”

Result: ‘define <setting value>

Note: This is only be considered in the setting item whose ‘value_type’ attribute
is set to ‘string’.

e Repeat steps above to configure all parameters as desired.
c. To configure Ports:
e  Click Ports from the Meta Data Tree, three port types (IN, OUT, INOUT) (Figure 3.18) are listed.

* Ports
I
ouT
= INOUT

Figure 3.18. Three Port Types
e  Right-click IN from the Ports area, and choose Add Port (Figure 3.19).

Meta Data
Basic Info

* Parameters
3

* Ports

o
= NG
Interfaces
Mernory M: Add Port

Infer Ports from HDL

Figure 3.19. Right-click Menu of the IN Port

Note: You can add all ports by using Infer Ports from HDL, if you prepare valid RTL files and add RTL files in Design
Files section. Click Infer Ports from HDL, the Add inferred ports to meta data wizard pops up (Figure 3.20). If you
have added some ports and then choose Infer Ports from HDL, all the previously-added ports are removed and
only ports from the HDL file can be added.
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™ Add i-I'IfEI'I'E:| ports ;c meta data h4
Inferred Ports Direction Range =
B ck i in
1 resetn i in
| Immi_wdata. in (310
| B Immi_rdata_o out 31,00
B Immi_rdata_valid_o out
| Immi_ready_o out
B Immi_wr_rdn_i in
B Immi_offset_i in (3,0
v Immi_request_i in
B int o out
v apb_penable_i in
v apb_psel_i in
v aphb_pwrite_i in
v | apb_paddr_i in (5,00
v | apb_pwdata_i in 31,0 -
oK Cancel

Figure 3.20. Add inferred ports to meta data Wizard
e NewPortl is created. Double click NewPort1 to rename the port (Figure 3.21).

* Ports
* [N
opio
2 ouT
O INOUT

Figure 3.21. Rename an IN Port

e  Configure all properties of the IN port as desired (Figure 3.22). Property listed in bold must be configured.
The details of each property is shown in Table 3.2.
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* Parameters Property Value '
4
range (IO_LINES_COUNT - 1, 0)
* Ports

conn_pert | gpic_i

clici conn_range
resetn_i . .
Immi_request_i stick_high
e stick low | EXTERNAL BUF == False
Immi_offset_i
Immi_wdata_i stick_wvalue
apb_penable_i :
apb_psel_i dangling
apb_pwrite_i :
apb_paddr_i attribute
apb_pwdata_i ot type
4 ouT
O INOUT
¥ |Interfaces
APB_SD
INTR
> Memory Map

F  gpio_mem_map

Figure 3.22. Configure an IN Port

Table 3.2. Details of Port Property

Property Value Mandatory Description

range Python tuple or list No Range of this port. It should be a Python expression whose
with two-integer evaluation result is a tuple or array with two elements.
elements Example:

range="(A_WDT-1, 0)”
(A_WDT is a setting ID)

conn_port Valid Verilog No Name of port of IP core module to which this port connects.
module name Value of “name” is used if “conn_port” is not specified.
Example:
conn_port="CIk"
conn_range Python tuple or list No Range of conn_port. It should be a Python expression whose
with two-integer evaluation result is a tuple or array with two elements.
elements Example:

conn_range="(A_WDT-1, 0)”
(A_WDT is a setting ID)

stick_high Python expression No Python script. True: tie this port to 1.
Example:
stick_high="True”

stick_low Python expression No Python script. True: tie this port to 0.
Example:

stick_low="no_seq_pins()”
(no_seq_pins is defined in plugin.py)

stick_value Python expression No Python script. Tie port to the evaluation result of this attribute.
Dangling Python expression No Python script. True: keep this port unconnected.
Example:

dangling="not USE_COUT”
(USE_COUT is a setting ID)

attribute Python expression No Python script. The value can be written to the .v file as the
attribute of the port.
Example:
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attribute=""(* AAA, BBB=1 *)"”

=>(* AAA, BBB=1*) input PORT;

port_type String No ‘data’, ‘reset’ and ‘clock’ are valid values. The default value is
‘data’.

Port_type can be passed to the IPXact component.xml as a
Isccip:isClk or Issccip:isRst node in venderExtensions in
component/model/ports/port.

e Repeat steps above to configure all ports as desired.

d. To configure Interfaces:
e  Right-click Interfaces from the Meta Data view, and choose Add Interface (Figure 3.23). A new interface
Newlnterfacel is created.

Add Interface

Figure 3.23. Right-click Menu of an Interface

e Double click NewlInterfacel to rename interface (Figure 3.24).

* |nterfaces
APE._S()

Figure 3.24. Rename Interface

e Configure the interface as desired (Figure 3.25).
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Figure 3.25. Configure an Interface

e Repeat steps above to configure all interfaces as desired.

User Guide
™1 IP Packager - Ci/lscc/workspace/IPs/gpio - [m| X
File Edit Help
= (g
L
Project Meta Data
Meta Data Basic Info
Design Files v Parameters Display Name: APE_S0
Test Bench r S
Misc v Ports Description: APEB slave port
Doc Assistant . . - APR: -
ro N Interface Type: amba.com:AMBA3: APB:r 1p0
O OUT o =
» @ INOUT o ==
~ Interfaces Mem Map Reference: | gpio_mem_map -
* Port Map:
¥ Memory Map Logical Port Physical Port
b gpic_mem_map
PADDR apb_paddr_i
PCLK
PCLKEN
PEMNABLE apb_penable_i
PRDATA apb_prdata_o
PREADY apb_pready_o
PRESETn
PSELx apb_psel_i
PSLVERR apb_pslverr_o
PWDATA apb_pwdata_i
PWRITE aph_pwrite_i
Application Output | &1 X
set ip directory: C:/lscc/workspace/IPs/gpio 4
load existing ipk project from C:/lscc/workspace/IPs/gpio
-
Output
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e. To configure Memory Map:
e  Right-click Memory Map from the Meta Data Tree, and choose Import Memory Map from CSV
(Figure 3.26). New memory map is created (Figure 3.27).
e Note: Propel 2022.1 Builder only supports using Import Memory Map from CSV to create memory map.
There are some issues if you use Add Memory Map.

Add Memory Map
Import Memory Map from C5V

Figure 3.26. Right-click Menu of a Memory Map
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1 1P Packager - C:/lscc/workspace/IPs/gpio [m] X
File Edit Help
= +
&
Project Meta Data
Meta Data Basic Info
Dresign Files ¥ Parameters Property Value
Test Bench 3 E d X P10
Misc - Potts escription memory map
Doc Assistant y OIN
v O ouT
v <D INOUT
¥ Interfaces
APB_SD
INTR.
* Memory Map
} igpio_mem_map
Application Output | &1 X
set ip directory: C:/lscc/workspace/IPs/gpio A
load existing ipk project from C:/lscc/workspace/IPs/gpio
-
Output

Figure 3.27. Generate New Memory Map
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2.

From the IP Packager Project area, click Design Files. IP Packager GUI shows the Design Files information

(Figure 3.28).
*1 IP Packager - Ci/lscc/workspace/IPs/gpio - [m| s
File Edit Help
& (£
Project Design Files
Add Remove
Lib Encryption

Misc

Doc Assistant

RTL Files:
MName

Ci/flscc/workspace/IPs/gpio/rtl/lscc_apb2immi.v
Ci/flsce/workspace/IPs/gpio/rtl/lscc_gpio.w

Ci/flscc/workspace/IPs/gpio/rtl/lscc_gpio_lmmiwv

Timing Constraint File:

Synplify Pro Constraint File:

Application Output | &1
set ip directory: C:/lscc/workspace/IPs/gpio
load existing ipk project from C:/lscc/workspace/IPs/gpio

Output

Figure 3.28. IP Packager with Design File Details

Click the Add button to select a desired rtl file in the Design Files field. Click the
remove an RTL file. Use the “...” option to add a desired timing constraint file and synplify Pro Constraint file.

Remove button to

Note: Design file configuration is mandatory. Specify at least one RTL file. If the RTL file needs to be

encrypted, check the Encryption option for it.
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3.

From the IP Packager Project area, click Test Bench. The Test Bench information is shown in detail (Figure 3.29).

1 IP Packager - C:/lscc/workspace/IPs/gpio - O X
File Edit Help
= +
4]
Project Test Bench
Meta Data
Design Files Testbench Files: Add Remove
Misc MName Lib Encryption
Doc Assistant Ci/flscc/workspace/IPs/gpio/testbench/lscc_ImmiZapb.y
C/flscc/workspace/IPs/gpio/testbench/tb_top.v
Application Output | &= X

set ip directory: C:/lscc/workspace/IPs/gpio
load existing ipk project from C:/lscc/workspace/IPs/gpio

Output

Figure 3.29. IP Packager with Test Bench Details

Follow the steps as those for configuring the Design Files to configure the Test Bench. The Test Bench files

configuration is not mandatory.
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4. From the IP Packager Project area, click Misc. The Misc related information is shown in detail (Figure 3.30).
Configure Misc information as desired.

*1 1P Packager - C:/lsce/workspace/IPs/gpio - [m] X
File Edit Help
—_ = +
L
Project Misc
Meta Data
Design Files Document: Add Remove
Test Bench
C:/lscc/workspace/IPs/gpio/doc/introduction.html
Doc Assistant
Driver Files: Add Remove
Ciflscc/workspace/IPs/gpio/driver/gpio.c x
C:/lscc/workspace/IPs/gpio/driver/gpic.h
1P Evaluation Files: Add Remove
Plugin File: | C:flscefworkspace TPs gpio/plugin/plugin.py
ELLA File:
Application Output | A_-| x
set ip directory: C:/lscc/workspace/IP=s/gpio &
load existing ipk project from C:/lscc/workspace/IPs/gpio
-
Output

Figure 3.30. IP Packager with Misc Details
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5. From the IP Packager Project area, click Doc Assistant. The Doc Assistant information is shown in detail
(Figure 3.31).
*1 1P Packager - Ci/lscc/workspace/IPs/gpio - ] X
File Edit Help
+

Z 1P
Project Doc Assistant
Met.a DET_:E This helps you quickly create an introduction html page for IP.
Design Files
Test Bench Title:
Misc

Description:

Device support:

Revision history:

Revision Content
Add Remaove Save and Add to IP Package
Application Output }_1 x
-

set ip directory: C:/lscc/workspace/IPs/gpic
load existing ipk project from C:/lscc/workspace/IPs/gpio

Output

Figure 3.31. IP Packager with Doc Assistant Details

Enter the desired title, description, and device in the Title, Description, and Device support fields accordingly.

)

o Double-click and enter a revision in Revision field. Double-click and enter revision contents in Content field.
Refer to Figure 3.32 as an example. Click the Add button. A new blank row is added to the Revision
History area. You can add desired revision and contents accordingly. Select the revision you want to delete, and
click the Remaove button to remove a Revision.

e C(Click the Save and Add to IP Package button to create an introduction html page and save this file to the IP
package.
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File Edit

& [=

Project

Meta Data
Design Files
Test Bench
Misc

Doc Assistant

I_'_"_“_I IP Packager -

Help
+

workspace/IPs/gpio

Doc Assistant

This helps you quickly create an introduction himl page for IP.

Title: GPIO

Description: General-Purpose InputfOutput (GPIO) peripheral IP provides dedicated memory-mapped

Device support: | ALL

Revision history:

Revision Content
1.6.0 Updated to support all devices
1.5.0 Added CertusPro-NX support, and updated G5R instance in testbench
141 Updated to fix combinational loop
140 Added MachX02, MachX03L, MachXO3LF support
13.0 Added option to remove tri-state buffer and Mach-NX device support
1.2.0 Added MachX03D and Certus-MX device support
1.1.0 Added CrossLink-NX device support
1.0.0 Initial release

Add Remove

interface to configure GPIO ports as well as the number of input and outy

Save and Add to IP Package

Application Output | &=

set ip directory: C:/lscc/workspace/IPs/gpio
load existing ipk project from C:/lscc/workspace/IPs/gpio

Output

Figure 3.32. Configure Doc Assistant
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3.2.3. Previewing IP

1. Choose Edit > IP Preview from Propel Builder menu. Or, click the IP Preview icon from Propel Builder

Toolbar.

2. IP Preview pops up showing the configuration component for the IP module (Figure 3.33), if the IP project
configuration is correct. Otherwise, the IP Packager pops up an error message (Figure 3.34).

[F 1P Preview bl

Configure Component from Module gpio
Version latticesemi.com

Set the following parameters to configure this component.

Diagram ippackager_preview_inst Configure IP
| Property Value
~ General
Murnber of 1/0 Lines [1 - 32] 1

Remove Tri-State Buffer
Initial Qutput Yalue (hex) [0 - FFFFFFFF] 0

ippackager_preview_inst 10 Direction (hex] [0 - FFFFFFFF] 1

PB SU Interface APB

" - INTR(4|
clk_i

_ gpio_io[0:0]
resetn_i
gpio
4 |2 - Mo DRC issues are found.
Cancel
Figure 3.33. IP Preview Shows Configuration for IP Module
-+
™1 IP Packager X

ERROR: No RTL file found.
Click the Add button te add mandatory IP input files --- meta data, RTL and
Document files.

OK

Figure 3.34. IP Packager Pops up Error Message
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3.2.4. Packaging IP
+ +
1. Choose Edit > Package IP from Propel Builder menu. Or, click the Package IP icon from Propel Builder
Toolbar.
2. IP Packager pops up a message showing the packaging is completed successfully (Figure 3.35).

o Package files to IP(Chlscc\workspaceh|Ps\gpichlatticesemi.com_gpio_1.6.0.ipk)

successfully.

8.4

Figure 3.35. IP Packager Pops up Successful Packaging Message

Note: When the setting value is changed, the packaging operation is disabled. You must perform a preview operation
before packaging. If the preview is successful, the packet operation is enabled. Otherwise, error messages are
displayed in the output widget.

3.3. Editing IP Package Files

3.3.1. Metadata File

Metadata.xml can be generated after editing IP. You also can manually edit the file. IP Platform uses XML file to
describe metadata of a soft IP. Namespace “Isccip” is used in XML file. The content of the XML file consists of three
mandatory nodes including <general>, <settings> and <ports>, five optional nodes including <businterfaces>,
<addressSpaces>, <memoryMaps>, <componentGenerators> and <estimatedResources>. One optional new child node
<outFileConfigs> is added to support the customized IP generation flow in Propel (Figure 3.36).

<lsccip:ip
xmlns:lsccip="http://www.latticesemi.com/XMLSchema/Radiant/ip"
xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
version="1.0">

<lsccip:general>

</lsccip:general>

<lsccip:settings>

</lsccip:settings>

<lsccip:ports>

</lsccip:ports>
</lsccip:ip>

Figure 3.36. Example XML of Metadata Layout

1. <general>node: describes general information about a soft IP, for example, name, version, and category. Table 3.3
shows the child nodes of <general> node.
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Table 3.3. Child Nodes of General Node

Child Node

Mandatory

Description

vendor

Yes

Soft IP vendor. Official soft IP should have vendor name.
Example:
“latticesemi.com”

library

Yes

Library of the soft IP. If “library” is not set, the default value “ip” is used.
Example:

wonou

ip”, “interface”

name

Yes

Name of the soft IP. The name must be unique among soft IP of the same
vendor and library.

Example:

“adder”

display_name

No

Name to be displayed in the software. If “display_name” is not set,
software displays “name” directly.

Example:

“Adder”

version

Yes

Version of the soft IP.
Example:
1.0.0

category

Yes

Category of the soft IP. Category can be hierarchical. Levels are separated
by “”".
Example:

keywords

No

Memory_Modules,Distributed_RAM

Keywords of the soft IP. Multiple keywords are separated by “,”.
Example:

BusType_AHB,BusType_APB

min_radiant_version

Yes

The minimal Radiant version, which supports the soft IP.
Example:
1.0 (no service pack), 1.0.1 (with service pack)

max_radiant_version

No

The maximal Radiant version, which supports the soft IP.
Example:
2.0.

supported_products

No

FPGA products supported by the soft IP.

Type

No

Enhancement for cpu IP.

Min_esi_version

No

The minimal ESI version, which supports the soft IP.
Enhancement for esi.

Max_esi_version

No

The maximal ESI version, which supports the soft IP.
Enhancement for esi.

Supported_platforms

No

Default is Radiant, specific for esi.
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2. <settings> node: describes parameters information that should contain one or more <setting> nodes. In an IP
instance package, Verilog parameters are used to configure the soft IP. All user configurable parameters should be
added to the <settings> section as <setting> nodes. Beside parameters, you can add <setting> nodes for user-input

only. Table 3.4 shows attributes of <setting> nodes.

Table 3.4. Attributes of Setting Nodes

Attribute Value Mandatory Description
id String Yes The unique ID of the setting, which is also be referred as:
Parameter name in RTL codes
Python variable name
Tcl variable name
To make value of the “id” valid in Verilog HDL, Python and Tcl, it should
consist of only letters, digits, and underscore. The first character should be
letter.
Example:
id="num_outputs”
title String No Short title of the setting. If “title” is not specified, value of “setting” is used.
Example:
title="Number of Output”
type param, input, | Yes A setting can be a Verilog parameter, Verilog macro definition or user input.
command Param, 112oo0lean_macro and input settings can be used to compute values
of other param and input settings. They only differ in generated files. Param
is written out as a Verilog parameter value pf the IP module,
11200lean_macro is translated to a Verilog macro definition by the define
compiler directives, but input is not. Command shows as a button.
Example:
type="param”
value_type bool, string, Yes Type of the value. Supported types are bool, int, float, string, and path.
int, float, The int type supports unlimited precision.
path The float type supports the precision of float type of C programming
language.
Refer to the Characteristics of Floating Types section of the 1999 ISO/IEC C
Standard for details.
The path type indicates a string which represents a path. “/” is used as
separator.
Example:
value_type="int"
default Python No Default value of the setting. If the setting has no “default” attribute but has
expression “options” attribute, the first option is picked as default value. If the setting
has neither “default” attribute nor “options” attribute, the initial value of
setting is set to O for int, 0.0 for float, “” for string and False for bool.
Example:
default="1.0"
value_expr Python No Python expression to compute the value of the setting. The result is used as
expression parameter value if the setting is not editable. For example, divider is
calculated by frequencies.
Example:
value_expr="int(round((sys_clock_freq * 250.0) /
i2c_left_desired_frequency))-1”
options Python listor | No Candidate options for the setting, which is used by GUI to display a
list of tuples dropdown selector. It can be set to a simple list or a list of tuples. Ifitisa
simple list, elements are displayed and written. If itis a list of tuples, the
first item in tuple is displayed and the second item in tuple is written.
Example:
options="[0.1, 0.2, 0.5, 1.0]”
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Attribute Value Mandatory Description

output_formatt | str No Control how parameter values are written in output RTL files. Following

er formatters are supported.

Str: parameter values are written as strings
nostr: quotation marks of strings are removed
Example:
output_formatter="str”
bool_value_ma Python tuple No The map-to-map bool values to dedicated strings. By default, bool values
pping or list with 2 are written as 1, 0.
string Example:
elements bool_value_mapping="(‘True’, ‘False’)”
editable Python No Python expression to determine if the setting is editable. When a setting is
expression not editable, it is grayed out in GUI display and its value is computed by
value_expr. Otherwise, user input is used.
Example:
editable="(FEEDBACK_PATH == ‘PHASE_AND_DELAY’)
(FEEDBACK_PATH is a setting ID in metadata.xml)

hidden True No Python expression to determine whether the setting is hidden in GUI. If
hidden is set to True (default is False), the item is hidden in GUI. The
expression is resolved to 113oo0lean value after the user setting is changed.
Example:
hidden="True”

drc Python No Python expression to do DRC on the setting. True means DRC pass.

expression Example:
drc="check_valid_addr_pre(12C_LEFT_ADDRESSING_PRE,i2c_left_addressing
_width)”
(check_valid_addr_pre is defined in plugin.py
setting ID: 1I2C_LEFT_ADDRESSING_PRE
i2c_left_addressing_width
)
regex Regular No Regular expression to do DRC on the value. For example, the value should
expression be prefixed by “Ob”.
Example:
regex="0b[01]+”
value_range Python tuple No Valid range of setting value, which is used to do DRC on the setting. The
or list with 2 maximum value can be infinity “float(‘inf’)”.
comparable Example:
elements value_range="(0, 1023) if(i2c_right_enable) else (-9999, 9999)”
config_groups Python No A name or names to group settings together. It is copied from IP-XACT
expression configGroups attribute, and only supports “SystemBuilder” value. If it is
defined, related RTL parameter is brought out to IP instance top module, so
that System Builder can re-define its value.

Description String No Detailed description of the setting.

Groupl String No Group the settings. Settings of the same “groupl” is displayed as sub-items
under a group item on GUL. The settings with the same “groupl” should be
written continuously if you want GUI to group them under one group item.
Otherwise, you can see multiple groups with the same name in GUI.
Example:
groupl= “Output Setting”

group2 String No Group the “groupl” groups. “groupl” groups of the same “group2” is

displayed in a separate page on GUI. So, two-level hierarchy is supported in
GUI display.

Unlike ‘groupl’, you need not write setting nodes with the same ‘group2’
continuously. You must follow the rule for ‘groupl’ that all the settings with
the same ‘groupl’ must be in the same ‘group2’.
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Attribute

Value

Mandatory

Description

Macro_name

id, value

No

Specify how to name the Verilog macro in ‘verilog_macro’ type setting item,

the ID or value of this setting item. The default value is ‘setting’, which
means the setting ID is defined as a Verilog macro. If it is set as ‘value’, the
evaluated setting value is the Verilog macro.

Example:

maro_name= “value”

Result: “define <setting value>

Note: This is only be considered in the setting item whose ‘value_type’
attribute is set to ‘string’.

3. <ports> node: IP module package has some ports in its implementation. These ports should be described in
<ports> section as <port> child nodes. If an input port is stuck to fixed value, or an output port is dangling, the port
is not used and is invisible after generation. Table 3.5 shows the attributes of <port> nodes.

Table 3.5. Attributes of Port Nodes

Attribute Value Mandatory Description
name Valid Verilog port Yes Name of a port.
name Example:
name="CIk”
dir in, out, inout Yes Direction of a port.
Example:
dir="in"
range Python tuple or list No Range of this port. It should be a Python expression whose
with 2 int elements evaluation result is a tuple or array with 2 elements.
Example:
range="(A_WDT-1, 0)”
(A_WDT is a setting ID)
conn_mod Valid Verilog Yes Name of an IP core module to which this port connects.
module name Example:
conn_mod="counter”
conn_port Valid Verilog No Name of port of an IP core module to which this port connects.
module name Value of “name” is used, if “conn_port” is not specified.
Example:
conn_port="CIk"
conn_range Python tuple or list No Range of conn_port. It should be a Python expression whose
with 2 int elements evaluation result is a tuple or array with 2 elements.
Example:
conn_range="(A_WDT-1, 0)”
(A_WDT is a setting ID)
stick_high Python expression No Python script. True: tie this port to 1.
Example:
stick_high="True”
stick_low Python expression No Python script. True: tie this port to 0.
Example:
stick_low="no_seq_pins()”
(no_seq_pins is defined in plugin.py)
stick_value Python expression No Python script. Tie port to the evaluation result of this attribute.
Dangling Python expression No Python script. True: keep this port unconnected.
Example:
dangling="not USE_COUT”
(USE_COUT is a setting ID)
bus_interface Valid bus interface No Bus interface name defined in <businterfaces> node.
name Example:
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Attribute Value Mandatory Description
bus_interface=" ahb_slave_0”

attribute Python expression No Python script. The value is written to the .v file as the attribute of
the port.
Example:

attribute=""(* AAA, BBB=1 *)”
=> (* AAA, BBB=1*) input PORT;

port_type String No ‘data’, ‘reset’ and ‘clock’ are valid values. The default value is
‘data’

port_type will be passed to the IPXact component.xml as a
Isccip:isClk or Issccip:isRst node in venderExtensions in
component/model/ports/port

<buslInterfaces> node: contains a list of all interface ports of the soft IP (Figure 3.37). The description follows
IP-XACT format. Refer to IEEE 1685-2014: |IEEE Standard for IP-XACT, Standard Structure for Packaging, Integrating,
and Reusing IP within Tool Flows for more details. The businterface has a list of portMap, which defines logicalPort
name and physicalPort name. In <ports> nodes, one port can have optional “bus_interface” attribute, which binds
the port with a businterface. If one port is bound to the businterface, its name should match physicalPort name of
one portMap of the businterface, so that port and busInterface/portMap is bound together. Whether or not a port
can be used is based on user configuration. If the port is used, the corresponding portMap in businterface is
written to the output IP-XACT file. Otherwise, the corresponding portMap in businterface is not written to the
output IP-XACT file.
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<lsccip:busInterfaces>
<lsccip:busInterface>
<lsccip:name>AHBL S00</lsccip:name>
<lsccip:displayName>AHBL S00</lsccip:displayName>
<lsccip:description>AHB-Lite slave
port</lsccip:description>
<lsccip:busType library="interface" name="ahblite"
vendor="1lattice" version="1.0"/>
<lsccip:abstractionTypes>
<lsccip:abstractionType>
<lsccip:abstractionRef library="interface"
name="ahblite rtl" vendor="lattice" version="1.0"/>
<lsccip:portMaps>
<lsccip:portMap>
<lsccip:logicalPort>
<lsccip:name>HSEL</lsccip:name>
</lsccip:logicalPort>
<lsccip:physicalPort>

<lsccip:name>ahbl s00 hsel slv i</lsccip:name>
</lsccip:physicalPort>
</lsccip:portMap>
<lsccip:portMap>
<lsccip:logicalPort>
<lsccip:name>HADDR</lsccip:name>
</lsccip:logicalPort>
<lsccip:physicalPort>

<lsccip:name>ahbl s00 haddr slv i</lsccip:name>
</lsccip:physicalPort>
</lsccip:portMap>
</lsccip:portMaps>
</lsccip:abstractionType>
</lsccip:abstractionTypes>
<lsccip:slave>
<lsccip:memoryMapRef memoryMapRef="ahbs mem map"/>
</lsccip:slave>
</lsccip:busInterface>
</lsccip:busInterfaces>

Figure 3.37. Example of businterface Node
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5. <addressSpaces> node: specifies the addressable area seen by bus interfaces of type master (Figure 3.38). The
description follows IP-XACT format. Refer to IEEE 1685-2014: IEEE Standard for IP-XACT, Standard Structure for
Packaging, Integrating, and Reusing IP within Tool Flows for more details.

<lsccip:addressSpaces>
<lsccip:addressSpace>
<lsccip:name>ahbm addr space</spirit:name>
<lsccip:range>4k</lsccip:range>
<lsccip:width>32</lsccip:width>
</lsccip:addressSpace>
</lsccip:addressSpaces>

Figure 3.38. Example of addressSpaces Node

6. <memoryMaps> node: specifies the information about the range of registers, memory, or other address blocks
accessible through slave interface (Figure 3.39). The description follows IP-XACT format. Refer to IEEE 1685-2014:
IEEE Standard for IP-XACT, Standard Structure for Packaging, Integrating, and Reusing IP within Tool Flows for more
details and examples.

To represent dynamic availability of some elements, <register> and <field> node are extended with an optional
isPresent element (introduced in IEEE Std 1685-2014), which defines whether the enclosing element is present or
not. The value of isPresent element is a Python expression. Parameters defined in <settings> node can be used in
the expression.

If a register is used based on user configuration, the register is written to output IP-XACT file. Otherwise, the
register is not written to output IP-XACT file.
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<lsccip:memoryMaps>
<lsccip:memoryMap>
<lsccip:name>ahbs mem map</lsccip:name>
<lsccip:description>AHB-Lite Slave 0 memory
map</lsccip:description>
<lsccip:addressBlock>
<lsccip:name>registers</lsccip:name>
<lsccip:displayName>registers</lsccip:displayName>
<lsccip:description>Register Block</lsccip:description>
<lsccip:baseAddress>0</lsccip:baseAddress>
<lsccip:range>4096</lsccip:range>
<lsccip:width>32</lsccip:width>
<lsccip:usage>register</lsccip:usage>
<lsccip:access>read-write</lsccip:access>
<lsccip:register>
<lsccip:name>Status</lsccip:name>
<lsccip:displayName>Status Register</lsccip:displayName>
<lsccip:description>Status Register</lsccip:description>
<lsccip:addressOffset>0x10</lsccip:addressOffset>
<lsccip:size>4</lsccip:size>
<lsccip:volatile>true</lsccip:volatile>
<lsccip:access>read-only</lsccip:access>
<lsccip:field>
<lsccip:name>FIFO Empty</lsccip:name>
<lsccip:displayName>FIFO Empty</lsccip:displayName>
<lsccip:description>Indicates current status of the

interface in the receive direction: 0 - There is data available. 1 - The
FIFO is empty.</lsccip:description>
<lsccip:isPresent> 1 != int setting

</lsccip:isPresent>
<lsccip:bitOffset>0</1lsccip:bitOffset>
<lsccip:bitWidth>1</lsccip:bitWidth>
<lsccip:volatile>true</lsccip:volatile>
<lsccip:access>read-only</lsccip:access>
<lsccip:writeValueConstraint>
<lsccip:minimum>0</lsccip:minimum>
<lsccip:maximum>0</lsccip:maximum>
</lsccip:writeValueConstraint>
<lsccip:testable
testConstraint="unConstrained">false</lsccip:testable>
</lsccip:field>
</lsccip:register>
</lsccip:addressBlock>
</lsccip:memoryMap>
</lsccip:memoryMaps>

Figure 3.39. Example of memoryMaps Node
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7. <componentGenerators> node: contains a list of componentGenerator elements. Each componentGenerator
element defines a generator that is run on generated IP instance package. Each generator is called after other IP
instance package files are generated. For example, a component generator can generate memory initialization file
for a memory IP (Figure 3.40).

<lsccip:componentGenerators>
<lsccip:componentGenerator>
<lsccip:name>memGenerator</lsccip:name>
<lsccip:generatorExe>script/mem gen.py</lsccip:generatorExe>
</lsccip:Generator>
</lsccip:Generators>
Figure 3.40. Example of componentGenerators Node
8.

<estimatedResources> node: contains a list of estimatedResource element. Each estimatedResource element

defines the formula to calculate one type of resource used in the IP instance package. Table 3.6 shows the element
in < estimatedResource> node.

Table 3.6. Elements in estimatedResources Node

Element Value Mandatory Description

name String Yes Name of the resource.

Number Python expression Yes Python script to calculate the number of the resource.
9.

<outFileConfigs> node: specifies all customized output file configuration nodes <fileConfig> for whole customized
flow. FileConfig node contains a group of attributes to specify a specific file or directory generation.
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A full description of a soft IP might be large. Metadata.xml supports to build a large XML file from small manageable
chunks. The approach is implemented by Xinclude (Figure 3.41).

metadata.xml
<lsccip:ip version="1.0"
xmlns:lsccip="http://www.latticesemi.com/XMLSchema/Radiant/ip"
xmlns:xi="http://www.w3.0rg/2001/XInclude">
<lsccip:general> .. </lsccip:general>
<xi:include href="setting.xml" parse="xml" />
<xi:include href="memory map.xml" parse="xml" />
<xi:include href="address space.xml" parse="xml" />
<xi:include href="bus interface.xml" parse="xml" />
<lsccip:ports> .. </lsccip:ports>
</lsccip:ip>

setting.xml
<lsccip:settings
xmlns:lsccip="http://www.latticesemi.com/XMLSchema/Radiant/ip">
<lsccip:setting id="int setting" type="input" value type="int"
conn _mod="example" default="1" title="Integer Setting" />
<lsccip:setting id="bool with value mapping" type="param"
value type="bool" conn mod="example"

default="False" bool value mapping="('Enabled',
'Disabled')" /> h h
</lsccip:settinas>

Figure 3.41. Example of Xinclude Usage

You can use metadata.xsd in Appendix A to check the metadata file. For those elements borrowed from IPXact, refer to
the related xsd files of IPXact.

3.3.2. Implementation RTL Files

You should put all IP implementation RTL files in ‘rtlI’ sub directory of whole IP package. Lattice Builder platform does
not support hierarchical rtl directories. All RTL sources can be put in one directory level. Three file suffix names (“.v/,
‘.sv’ and ‘.vhd’) are supported for RTL files to represent ‘Verilog’, ‘System Verilog’ and ‘Vhdl’ language types
accordingly.

IP Platform always generates a wrapper module by default for the whole IP generation. This wrapper is in Verilog HDL
no matter what the language type of the IP implementation RTLs is. Providing a Verilog-HDL top to handle the interface
translation among different language types is strongly recommended.

If the IP is implemented in Verilog HDL (including System Verilog) only, all the contents are copied in one .v/.sv RTL file
and modules are defined in the wrapper top module. All module names have unified naming rule to avoid name
collision such as Top module name, PMI module name, Primitive module name, Blackbox module name.

If some portions of an IP module in the RTL file are encrypted, the corresponding portions generated in Verilog file are
also encrypted.
All the RTLs are kept and copied to an IP instance directory, if there is VHDL in IP implementation RTLs. Therefore, the

module-naming rule does not need to be unified. You can specify different lib (default is work) for VHDL source that is
specified in “wrapper” file generator (Figure 3.42).

<lsccip:outFileConfigs>
<lsccip:fileConfig name="wrapper" lib='test2.vhd=1ibA;test3.vhd=1ibB' />
</lsccip:outFileConfigs>

Figure 3.42. Example of Specifying Lib for VHDL
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3.3.3. Python Script Plugin File

Python expressions can be used in metadata file to implement complex logic. To support complex logic, you can add
any python functions in plugin.py file (Figure 3.43) of an IP package, and then call the functions in Python expressions in
metadata file.

Each setting item value can be referred to in a Python expression in metadata.xml by its ID as a Python variable. An
expression is evaluated by demand. The plugin has its individual namespace and all the setting items values are
exported to plugin as a global map variable IP_SETTINGS. You can use IP_SETTINGS [item ID] to refer to an item or set
its value in plugin code.

A global variable ‘*__PLUGIN_VER’ is defined with value ‘2.0’. You can check this variable if you want to provide a plugin
that can work on both current and legacy IP platforms.

def cntr_opt():

{"Down" =0,
L -_TE n 1
E "UpDown™:2}
return [("D

e D),
r —}f
\—II' :}]
def cntr ldir(}:
return ((CNTR DIR = 0) | (CHTR DIR = 1})

def cntr_wdt():
if (CHNTR _WIDTIH < 2):
return 2
else:

return CHNTE_WIDTH

def cntr hval check():
if (CHNTE_HVALUE <= CNTR_LVALUE):

ret = 0

PluginUtil.post_error("Higher count wvalus should be greater than the Lower count value.™)
else:

ret = 1

return ret

¥ = runtime info.device info.architecture (values)

Tdef get_device name (value):
retorn =

Figure 3.43. Template of Plugin File
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3.3.4. Memory Map CSV File

Propel 2022.1 Builder supports importing memory map from a CSV file to create memory map. You can edit a CSV file.
Figure 3.44 shows the CSV file template. Each row to be imported is with one of the keywords among MEMORYMAP,
REGISTER, and FIELD. Row with no keyword is ignored, such as the header row (orange squared part in Figure 3.44).
The header row is to help identify the column.

A B T D E F G H | ]
I 0 1 4 5 7 3 E)

2 | name description baseAddress range width

3 |MEMORYMAFP ABC descl 0x0 32 64

4 | name displayMame  description addressOffset size volatile access

3 |REGISTER QSPI_CTRL QSPI_CTRL Q5PI Control Register 0x00 32 TRUE read-write

6 | field displayMame  description bitOffset bitWidth volatile access default testable

DEFAULT_S
7 |FIELD spi_mode spi_mode Sets the SPI mode 0 2 TRUE read-write PI_MODE TRUE
DEFAULT_S

& |FIELD sck_div sck_div Sets the SPI clock divider 3 TRUE read-write CK_DIV TRUE

9 |FIELD reserved reserved Reserved bits 5 26 TRUE read-write 0 TRUE

10 |FIELD soft_reset soft_reset Resets internal soft logic 31 1 TRUE read-write 0 TRUE

11 | name displayMame  description addressOffset size volatile access

12 |REGISTER CMD_DATA CMD_DATA Command Data Register 0x04 32 TRUE read-write

13 | field displayMame  description bitOffset bitwidth volatile access default testable
Command data to transmit
in transaction phase 1

14 |FIELD cmd_data cmd_data (always big endian) 0 32 TRUE read-write 0 TRUE

15 | name displayMame  description addressOffset size volatile access

16 |REGISTER TX_FIFO_DATA TX_FIFO_DATA Tx FIFO Data Register 0x08 32 TRUE write-only

17 name displayMame  description bitOffset bitWidth volatile access default testable
Data to transmit in

18 |FIELD tx_fifo_data  tx_fifo_data  transaction phase 2. 0 32 TRUE write-only MNA FALSE

Figure 3.44. Example of Memory Map CSV File
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4. TCL Commands

Propel Builder provides TCL commands to execute actions. You can manually enter TCL commands in Tcl Console
(Figure 4.1), if you prefer using command lines rather than using the GUI.

Tdl Console

% sbp design close
INFO - Finished: sbp design close
Finished: "sbp_design close™

% sbp design open -name hellc v -path {G:/Lattice/project/Raptor/tool/hw/hello_v/hello_v/hello_v.sbx}
% sbp design close

INFO - Finished: sbp design close
Finished: "sbp design close™

Figure 4.1. Tcl Console

4.1. sbp_design

The sbp_design command is used as one of the high-level management commands such as opening, closing, of the
design files created by the Propel Builder.

4.1.1. Open

Opens an existing Propel Builder design for modification.

Usage sbp_design open -name <design name> -path <design path> [-device <device name>]

Example sbp_design open -name projectl -path projectl.sbx

4.1.2. Close

Closes a Propel Builder design currently opened.

Usage |sbp_design close

4.1.3. New

Creates a new Propel Builder design.

Usage sbp_design new -name <new design name> -path <new design path> -device <device name> -

language <language type > —board <board name>

4.1.4. Save

Saves the current Propel Builder design to file on disk or save it as a new file. You can choose to save the design to the
project location (Example 1) or to a specific path (Example 2).

Usage sbp_design save [-path <new design path>]
Example 1 sbp_design save
Example 2 sbp_design save -path new_design.sbx
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4.1.5. Drc
Runs the design rule check for the Propel Builder design file.
Usage sbp_design drc

4.1.6. Generate

Generates RTL code to instantiate and connect the IP cores specified in the Propel Builder design file.
Usage ‘sbp_design generate

4.1.7. Auto Assign Addresses

Automatically assighs memory mapped addresses to all the slaves in the system. These addresses should be chosen to
avoid slaves with multiple non-contiguous address ranges.
Usage sbp_design auto_assign_addresses

4.1.8. Verify

Launches the SOC verification engine to verify design.
Usage sbp_design verify [-h] [--workfolder <workfolder_path>] [--sbx_file <sbx_file_path>]
{sim_gen,pfr_pack,regmap_gen,auto_run}

positional arguments: {sim_gen,pfr_pack,regmap_gen,auto_run} specify the application

sim_gen Simulation Generation Flow
pfr_pack PFR Security Engine Packager Flow
regmap_gen Memory Map Generation Flow
auto_run Automation Flow

optional arguments:
-h, --help show this help message and exit
--workfolder WORKFOLDER, -wf WORKFOLDER
assign the working folder. Otherwise, the default one (current working folder) will be
used
--sbx_file SBX_FILE, -sf SBX_FILE
specify the sbx file

Example sbp_design verify —workfolder ./mem_map —sbx_file D:/ /XO3D_Initial/XO3D_lInitial.sbx regmap_gen

4.1.9. PGE

Runs command with different parameters to call SGE function, DGE function, and Signature inside of PGE (Package
Generate Engine).

e  Runs command to call SGE to generate files for SDK.

Usage sbp_design pge sge —I <input path> [-o0 <output path>]

-i [Required] the top-level SoC project sbx file full path.

-0 [Optional] output full path, if the parameter is not specified, output path is the same as SoC
project path. sge folder is generated at output path, at present sge folder under the SoC project root
directory.
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e  Runs command to call DGE to generate TCL script that can be used to generate a Diamond or Radiant project.
Usage sbp_design pge dge —i <input path> [-o <output path>] [-diamond [-radiant]

-i [Required] the top level SoC project sbx file full path.

-0 [Optional] output full path, if the parameter is not specified, output path is the same as SoC
project path. For DGE, tcl script and related files are generated at output path. At present, Diamond
or Radiant project share the same workspace with SoC project.

-diamond [Optional] flag to execute DGE for diamond project.

-radiant [Optional] flag to execute DGE for Radiant project.

e  Run command to generate signature.

e  PGE gets partial UFM3 contents including version packetl), Sentry PFR configure data (D), and call Flash Address
Tool to sign with private key from Factory HSM.

Usage ‘sbp_design pge gen_signature -cfile <c binary file> -dfile <d binary file> -output <output binary file>
4.1.10.Undo

Undo operation. Currently, software only supports single undo.

Usage |sbp_design undo

4.1.11.Redo

Redo operation. Currently, software only supports single redo.

Usage |sbp_design redo

4.1.12. Set Device

Modify the device information including device, package, speed, operating condition.
Usage sbp_design set_device -device <device name> -speed <speed value> -package <package value> -
operating <operating condition>

4.2. Other TCL Commands

The following commands are used for specifying connectivity and IP instantiation to the Propel Builder backend.

4.2.1. sbp_add_component

Instantiates an IP component into the system. Must specify the component VLNV identifier. This corresponds to a
component instance in the IP-XACT design. For example, the command below can instantiate an AHB-Lite interconnect
component.

Usage sbp_add_component -vinv <VLNV> -name <instance_name>

Example sbp_add_component -vinv lattice:ip:ahbl_interconnect:1.0 -name ahblite_interconnect
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4.2.2. sbp_add_sbxcomp

Instantiates a hierarchical component from sbx file into the system.
Usage sbp_add_sbxcomp -name <hname> -path <sbx_file_absolute_path_name>

Example sbp_add_sbxcomp -name sim_comp -path “C:/test/test.sbx”

4.2.3. sbp_add_gluelogic

Instantiates a gluelogic component into the system.
Usage sbp_add_gluelogic —name <instance_name> -logicinfo <logic json info from sbp_create_glue_logic>

Example sbp_add_gluelogic -name equation_module_inst -logicinfo [sbp_create_glue_logic equation
equation_module {}“{{""x"r":"IA” ”B","module_"a”e":"equation_mo”ule"}}]
Note: This is an internal command. Modify existing usage is not recommended.

4.2.4. sbp_create_glue_logic

Create gluelogic information when adding gluelogic component. rtl_path must be a file path if gluelogic comes from a
file. Else be empty.
Usage sbp_create_glue_logic <type> <module_name> <rtl_path> <json cfg data>

Example sbp_add_gluelogic -name equation_module_inst -logicinfo [sbp_create_glue_logic equation
equation_module {}“{{""x"r":"IA” ”B","module_"a”e":"equation_mo”ule"}}]
Note: This is an internal command. Modify existing usage is not recommended.

4.2.5. sbp_add_port

Creates a top-level I/0 port. Must specify the direction.
‘Usage ‘sbp_add_port [-from <bit number>] [-to <bit number>] -direction <in/out/inout> <port_name>

4.2.6. sbp_modify_port

Modify existing top-level ports to change the width and the direction.
‘Usage sbp_maodify_port -name <port_name> [-from <bit number>] [-to <bit number>] -direction <dir>

4.2.7. sbp_connect_net

Connects all of the specified pins and/or ports to the same net. The arguments can be pins or ports in the system
design. Only one of the arguments can be the driver (output pin/port), driving all other input pin/ports. Example below
connects the clk port to all components, assuming component pins are all named clk.

Usage sbp_connect_net [-name <net name>] <pin/port> <pin/port>

Example sbp_connect_net [sbp_get_pins clk] {CLOCK_IN}

4.2.8. sbp_connect_interface_net

Connects a bus interface pin/port to another interface pin/port. This corresponds to the interconnection element in the
IP-XACT design.
‘Usage ‘sbp_con nect_interface_net <pin/port> <pin/port>

4.2.9. sbp_connect_constant

Connects a constant integer to a pin/pinbus/port/portbus. To assign to a pin/pinbus, the object must be an input
pin/pinbus. To assign to a port/portbus, the object must be an output port/portbus. If the integer requires multiple
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bits, not 0 or 1, then the object must be a bus. The tcl command can be used to assign the same constant to multiple
pin/pinbus/port/portbus at the same time.

Usage sbp_connect_constant -constant <integer> <pin/pin bus/ port/portbus> <pin/pin bus/
port/portbus>...
Example sbp_connect_constant -constant 1 {test/i2c_mst_apb/rst_n_i} {test/riscv/clk_i}

4.2.10. sbp_connect_whitebox

User can do connection cross the hierarchy boundary for verification purpose.

Usage sbp_connect_whitebox <design_name/vip_inst_name/pin_name>
<design_name/uit_inst_name/port_name>

4.2.11. sbp_disconnect_whitebox

Removes the connection cross the hierarchy boundary.

Usage sbp_disconnect_whitebox <design_name/vip_inst_name/pin_name>
<design_name/uit_inst_name/port_name>

4.2.12. sbp_disconnect_interface_net

Disconnects an interface pin/port from the interface nets they attached to. Note that any interface pin or interface port
can attach to one interface net at the most.
‘Usage |sbp_disconnect_interface_net <pin/port> <pin/port>

4.2.13. sbp_disconnect_net

Disconnects all of the specified input pins and/or ports from the nets they attached to. Note that any pin or port can
attach to one net at the most. Can also be used to disconnect a constant that is connected to a pin/port with
connect_constant.

‘Usage |sbp_disconnect_net <pin0> <pinl><port2>

4.2.14. sbp_assign_addr_seg

Assigns a memory map between a pair of master and slave interfaces. Range specifies the range of the segment, for
example, 32'h0000400, 32'‘h0001000. Offset specifies the base offset of the range, for example, 32‘h0000400
Usage sbp_assign_addr_seg -offset <offset> <slave connection name>

Example sbp_assign_addr_seg -offset 32‘h00001000 simple/riscv/AHBL_S00

4.2.15. sbp_unassign_addr_seg

The Tcl command unsets the fixed offset flag for a memory map allowing the auto_assign Tcl command to assign the
memory map offset.
Usage sbp_unassign_addr_seg <slave interface name>

Example sbp_unassign_addr_seg simple/spi/AHB_S00

4.2.16. sbp_assign_local_memory

Assigns a base address to a local memory map of a master address space.
Usage sbp_assign_local_memory -offset <offset> <master_addr_space>

Example sbp_assign_local_memory -offset ‘h0050000 Foundation_SoC/riscv/ahbl_m_data_Address_Space
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4.2.17. sbp_export_pins

Exports a list of pins or interface pins, or all not-yet-connected pins of the components to the top-level port list in the
design. The function detects whether or not the argument is pin(s) or component(s). In the two examples below,
Example 1 demonstrates a Tcl command to export the pin init_done, while Example 2 demonstrates a Tcl command to
export all pins and interfaces of the ddr3 component.

Usage sbp_export_pins <pin/component> <pin/component>
Example 1 sbp_export_pins {ddr3/init_done}
Example 2 sbp_export_pins {ddr3}

4.2.18. sbp_export_interface

Exports bus interfaces that are passed as arguments to the Tcl command from the component to the top-level
component. Example below exports the AHBL_MASTER bus interface of the RISC-V component to the top-level
component.

Usage sbp_export_interfaces <interface> <interface> <interface>

Example sbp_export_interfaces simple/riscv/AHBL_MASTER

4.2.19.sbp_rename

The rename Tcl command renames objects within the design. The new name of the object and the current hierarchical
name of the given object are used as the parameter value. The object can be an interface connection, connection, port,
interface, or component. The example below demonstrates the changing of the name of a port in milestone project
from CLK to CLOCK.

Usage sbp_rename -name <new name> <object name>

Example sbp_rename -name CLOCK milestone/CLK

4.2.20. sbp_replace

The Replace (Re-Config) Tcl command replaces a component with a new configuration for itself. VLNV refers to the
newly-generated IP, component name refers to the existing component that is to be replaced, and instance refers to
the instance name of the component with new configuration.

Usage sbp_replace -vinv <VLNV> -name <instance> -component <component name>

Example sbp_replace -vinv lattice:ip:ahblite_bus_0:1.1 -name ahbl_bus_0 -component simple/ahblite

4.2.21. sbp_copy

Copies objects, IP instances and nets, from the current or other open sbp designs to the current sbp design. All objects
are post-fixed with a postfix string. For example, you can write TCL code below to duplicate the components and
connections with new instance names post fixed with X, by calling copy on all the components, ports and nets. Pins are
automatically duplicated while the components are duplicated.

Usage sbp_copy -postfix <postfixString> objects

Example sbp_copy —postfix X Sselected_objs
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4.2.22.sbp_delete

Deletes objects, IP instances and nets, from the current sbp design. In the examples below, Example 1 demonstrates a
Tcl command to delete a port, while Example 2 demonstrates a Tcl command to delete ddr3 component.

Usage Sbp_delete objects -type <type name>
Example 1 sbp_delete [sbp_get_ports <clock>] -type port
Example 2 sbp_delete {ddr3} -type component

4.2.23.sbp_get_pins

Gets a list of pin names that match a pattern string, and/or the pins that are associated with an object. The object in
the [-from <objectName>] option can be a net or a component. The example below gets the clk pin from the
interconnect IP.

Usage sbp_get_pins [-from <object Name>] [pattern]

Example sbp_get_pins -from ahblite_interconnect clk

4.2.24.sbp_get_interface_pins

Gets a list of interface names that match a pattern string, and/or the interfaces that are associated with an object. The
object in the [-from <objectName>] option can be an interface net or a component. The example below can get all
AHB-Lite slave interface pins from the interconnect IP.

Usage: sbp_get_interface_pins [-from <objectName>] [pattern]

Example: sbp_get_interface_pins -from ahblite_interconnect S*_AHB

4.2.25.sbp_get_ports

Get a list of the names of ports that match a pattern string, and/or the ports that are associated with an object. The
object in the [-from <objectName>] option can be a net.

Usage lsbp_get_ports [-from <objectName>] [pattern]

4.2.26.sbp_get_interface_ports

Gets a list of interface names that match a pattern string, and/or the interface ports that are associated with an object.
The object in the [-from <objectName>] option can be an interface net.

‘Usage Isbp_get_interface_ports [-from <objectName>] [pattern]

4.2.27.sbp_get_nets

Gets a list of net names that match a pattern string, and/or the nets that are associated with an object. The object in
the [-from <objectName>] option can be a pin or a port.

‘Usage ‘sbp_get_nets [-from <objectName>] [pattern]

4.2.28. sbp_get_interface_nets

Gets a list of interface net names that match a pattern string, and/or the interface nets that are associated with an
object. The object in the [-from <objectName>] option can be an interface pin or an interface port.

‘Usage ‘sbp_get_interface_nets [-from <objectName>] [pattern]
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4.2.29. sbp_set_property

Sets the properties of an input object. The first argument is a list of name value pairs. We have a list of parameters
because the GUI IP configuration dialog submits changes to many parameters of an IP component at the same time
when the dialog is closed. In the examples below, Example 1 changes the data width of the RAM block named “ebr_0",
while Example 2 changes the number of master interfaces to two and number of slave interface to three on AHB-Lite
interconnect block named “ahbl_interconnect”.

Usage sbp_set_property <nameO valueO namel valuel ...> object
Example 1 sbp_set_property {datawidth 32} {test/ebr_0}
Example 2 sbp_set_property {NUM_MI 2 NUM_SI 3} test/ahbl_interconnect

4.2.30. sbp_get_property

Gets the property of the object. The example below is to get the number of slave interfaces of AHB-Lite interconnect
block named “ahbl_interconnect_0".
Usage sbp_get_property <parameter name> <object>

Example sbp_get_property NUM_SI ahbl_interconnect_0

4.2.31.sbp_report_properties

Prints all the properties and values associated to the type of the object.
Usage sbp_report_properties object

Example sbp_report_properties ahbl_interconnect

Outputs Name: ahbl_interconnect
NUM_SI: 1

NUM_MI: 2
DATA_WIDTH: 32
IADDRESS_WIDTH: 32

4.2.32.sbp_get_components

Gets a list of component names that match a pattern string, and/or the components that are associated with an object.
The default pattern string is a wildcard “*” that matches all components. The pattern string may consist of string
segments and wildcards. The example below returns all the component names that contain “interconnect”. The
command returns an empty string if no match is found.

Usage sbp_get_components <component name>

Example sbp_get_components {*interconnect*}
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Appendix A. metadata.xsd

<?xml version="1.0" encoding="gb2312"?>

.0.1 22-Jul-2016 1. removed enum value from <setting> 2. change

removed GUI out of metadata scope
add value list support
new features in Radiant 3.0

<!-- IP Metadata Schema 0.0.5 -->
<!--
Change Log:
0.0.0 21-Jul-2016 initial revision.
0
value mapping to scriptType
0.0.2 29-Jul-2016 1.
0.0.3 30-Jul-201l6 1.
0.0.4 07-Jan-2021 1.
0.0.5 06-Apr-2021 1

-—>

<xs:schema

<xXs

<Xs:
<xXSs:
<xXSs:

<xSs

<xSs

fully support Verilog macro

xmlns:xs="http://www.w3.0rg/2001/XMLSchema"

targetNamespace="http://www.latticesemi.com/XMLSchema/Radiant/ip"
xmlns:lsccip="http://www.latticesemi.com/XMLSchema/Radiant/ip"
elementFormDefault="qualified"
attributeFormDefault="unqualified">

<xs:import schemalocation="xml.xsd"
namespace="http://www.w3.0rg/XML/1998/namespace" />
:include schemalocation="busInterface.xsd"/>

include schemalLocation="memoryMap.xsd"/>
include schemalLocation="file.xsd"/>
include schemalLocation="generator.xsd"/>

:include schemalocation="design.xsd"/>

rattributeGroup name="ipany.att">
<xs:anyAttribute processContents="lax"/>
</xs:attributeGroup>
<!-- version string type definition-->
<xs:simpleType name="threeFigureVersionType">
<xs:annotation>
<xs:documentation>
The syntax for version string.

</xs:documentation>

</xs:annotation>

<xs:restriction base="xs:string">

<xs:pattern value="[0-9]+\.[0-9]+\.[0-9]+"/>
</xs:restriction>

</xs:simpleType>

<xs:simpleType name="twoFigureVersionType">
<xs:annotation>
<xs:documentation>
The syntax for Radiant version string.

</xs:documentation>

</xs:annotation>
<xs:restriction base="xs:string">
<xs:pattern value="[0-9]+\.[0-9]+"/>
</xs:restriction>
</xs:simpleType>

<xs:simpleType name="scriptType">
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<xs:annotation>
<xs:documentation>
Any python expressions. Could be a simple const variable like
&quot;l&quot;,
or a tuple &quot; (0, 10)&quot;, or a function call
&quot;user funcl () &quot;,
or a complex expression &quot;a==l2&quot;
</xs:documentation>
</xs:annotation>
<xs:restriction base="xs:string"/>
</xs:simpleType>

<xs:simpleType name="settingTypeType">
<xs:annotation>
<xs:documentation>
Is this setting variable for parameter of IP core module, verilog macro,
or just for user input?
Valid values are &quot;inputé&quot;, &quot;verilog macro&quot;,
&quot;paramé&gquot;, and &quot;command&quot; . -
</xs:documentation>
</xs:annotation>
<xs:restriction base="xs:string">
<xs:enumeration value="param"/>
<xs:enumeration value="input"/>
<xs:enumeration value="verilog macro"/>
<xs:enumeration value="command"/>
</xs:restriction>
</xs:simpleType>
<xs:simpleType name="settingMacroNameType">
<xs:annotation>
<xs:documentation>
Specify what is used to name the Verilog macro, ID or Value?
Valid values are &quot;id&quot; and &gquot;value&quot; .
</xs:documentation>
</xs:annotation>
<xs:restriction base="xs:string">
<xs:enumeration value="id"/>
<xs:enumeration value="value"/>
</xs:restriction>
</xs:simpleType>

<xs:simpleType name="settingValueType">

<xs:annotation>

<xs:documentation>
Value type of setting variable. Valid types are &quot;boolé&quot;,
&quot;string&quot; and &quot;inté&quot;

</xs:documentation>

</xs:annotation>

<xs:restriction base="xs:string">
<xs:enumeration value="bool"/>
<xs:enumeration value="string"/>
<xs:enumeration value="int"/>
<xs:enumeration value="float"/>
<xs:enumeration value="path"/>
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</xs:restriction>
</xs:simpleType>
<xs:simpleType name="settingDefaultType">
<xs:annotation>
<xs:documentation>
Default value of setting wvariable.
</xs:documentation>
</xs:annotation>
<xs:restriction base="xs:string"/>
</xs:simpleType>
<xs:simpleType name="settingOutputFormatterType">
<xs:annotation>
<xs:documentation>
Formatter of output.
</xs:documentation>
</xs:annotation>
<xs:restriction base="xs:string">
<xs:enumeration value="str"/>
<xs:enumeration value="nostr"/>
</xs:restriction>
</xs:simpleType>
<!-- ip.settings.setting-->
<xs:complexType name="settingElementType">
<xs:annotation>
<xs:documentation>
Setting variable definition.
</xs:documentation>
</xs:annotation>
<xs:attribute name="id" type="xs:string" use="required" />
<xs:attribute name="type" type="lsccip:settingTypeType"
use="required" />
<xs:attribute name="value type" type="lsccip:settingValueType"
use="required" />
<xs:attribute name="conn mod" type="xs:string" use="required" />
<xs:attribute name="domain" type="xs:string" use="optional" />
<xs:attribute name="default" type="lsccip:settingDefaultType"
use="optional" />
<xs:attribute name="value expr" type="lsccip:scriptType"
use="optional" />
<xs:attribute name="drc" type="lsccip:scriptType" use="optional" />
<xs:attribute name="editable" type="lsccip:scriptType"
use="optional" />
<xs:attribute name="description" type="xs:string" use="optional"
<xs:attribute name="title" type="xs:string" use="optional"
<xs:attribute name="hidden" type="xs:string" use="optional"
<xs:attribute name="regex" type="xs:string" use="optional"
<xs:attribute name="options" type="lsccip:scriptType"
use="optional" />
<xs:attribute name="value range" type="lsccip:scriptType"
use="optional" />
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<xs:attribute name="groupl" type="xs:string" use="optional" />
<xs:attribute name="group2" type="xs:string" use="optional" />
<xs:attribute name="bool value mapping" type="lsccip:scriptType"
use="optional" />
<xs:attribute name="output formatter"
type="1lsccip:settingOutputFormatterType" use="optional" />
<xs:attribute name="config groups" type="lsccip:scriptType"
use="optional" />
<xs:attribute name="process path" type="xs:boolean" use="optional"
default="true">
</xs:attribute>
<xs:attribute name="macro name" type="lsccip:settingMacroNameType"
use="optional" -
default="1id">
</xs:attribute>
<xs:attribute ref="xml:base" use="optional"/>
<xs:attribute name="no dependency" type="xs:string" use="optional" />
</xs:complexType>

<!-- ip.settings -->
<xs:complexType name="settingsType">

<xs:sequence>

<xs:element minOccurs="0" maxOccurs="unbounded" name="setting"
type="1lsccip:settingElementType" />

</xs:sequence>

<xs:attribute ref="xml:base" use="optional"/>
</xs:complexType>

<!-- ip.ports.port-->
<xs:complexType name="portElementType">

<xs:annotation>
<xs:documentation>IP port definition.</xs:documentation>

</xs:annotation>

<xs:attribute name="name" type="xs:string" use="required" />

<xs:attribute name="dir" type="xs:string" use="required" />

<xs:attribute name="conn mod" type="xs:string" use="required" />

<xs:attribute name="conn port" type="xs:string" use="optional" />

<xs:attribute name="conn range" type="xs:string" use="optional" />

<xs:attribute name="range" type="lsccip:scriptType"
use="optional" />

<xs:attribute name="stick high" type="lsccip:scriptType"
use="optional" />

<xs:attribute name="stick low" type="lsccip:scriptType"
use="optional" />

<xs:attribute name="stick value" type="lsccip:scriptType"
use="optional" />

<xs:attribute name="dangling" type="lsccip:scriptType"
use="optional" />

<xs:attribute name="bus_ interface" type="xs:string"
use="optional" />

<xs:attribute name="attribute" type="lsccip:scriptType"
use="optional" />

<xs:attribute name="port type" use="optional" default="data">
<xs:simpleType>
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<xs:restriction base="xs:string">
<xs:enumeration value="data"></xs:enumeration>
<xs:enumeration value="reset"></xs:enumeration>
<xs:enumeration value="clock"></xs:enumeration>
</xs:restriction>
</xs:simpleType>
</xs:attribute>
<xs:attribute ref="xml:base" use="optional"/>
</xs:complexType>
<!-- ip.outFileConfigs -->
<xs:complexType name="outFileConfigsType">
<xs:sequence>
<xs:element maxOccurs="unbounded" name="fileConfig"
type="1sccip:fileConfigType" />
</xs:sequence>
</xs:complexType>
<!-- ip.outFileConfigs.fileConfig -->
<xs:complexType name="fileConfigType">
<xs:annotation>
<xs:documentation>Configure output file</xs:documentation>
</xs:annotation>
<xs:attribute name="name" type="xs:string" use="required" />
<xs:attribute name="use" use="optional" default="merge">
<xs:annotation>
<xs:documentation>
Merge the new attributes to existing configuration or
replace all
</xs:documentation>
</xs:annotation>
<xs:simpleType>
<xs:restriction base="xs:string">
<xs:enumeration value="merge"></xs:enumeration>
<xs:enumeration value="replace"></xs:enumeration>
</xs:restriction>
</xs:simpleType>
</xs:attribute>
<xs:attribute name="type" use="optional" default="file">
<xs:annotation>
<xs:documentation>
Indicate the item is generate a file or directory
</xs:documentation>
</xs:annotation>
<xs:simpleType>
<xs:restriction base="xs:string">
<xs:enumeration value="file"></xs:enumeration>
<xs:enumeration value="directory"></xs:enumeration>
</xs:restriction>
</xs:simpleType>
</xs:attribute>
<xs:attribute name="description" type="xs:string"
use="optional">
</xs:attribute>
<xs:attribute name="enable output" type="xs:string" use="optional"
default="True">

© 2022 Lattice Semiconductor Corp. All Lattice trademarks, registered trademarks, patents, and disclaimers are as listed at www.latticesemi.com/legal.
All other brand or product names are trademarks or registered trademarks of their respective holders. The specifications and information herein are subject to change without notice.

FPGA-UG-02177-1.0 135


http://www.latticesemi.com/legal

Lattice Propel 2022.1 Builder ....LATTICE

User Guide

<xs:annotation>
<xs:documentation>
Python expression represent a boolean value to
indicate the output is enabled or disabled
</xs:documentation>
</xs:annotation>
</xs:attribute>
<xs:attribute name="phase" type="xs:int" use="optional"
default="0">
</xs:attribute>
<xs:attribute name="file base name" type="xs:string"
use="optional">
</xs:attribute>
<xs:attribute name="file suffix" type="xs:string"
use="optional">
</xs:attribute>
<xs:attribute name="sub dir" type="xs:string"
use="optional"></xs:attribute;
<xs:attribute name="file generator" type="xs:string"
use="optional">
</xs:attribute>
<xs:attribute name="src dir" type="xs:string"
use="optional">
</xs:attribute>
<xs:attribute name="dest dir" type="xs:string"
use="optional">
</xs:attribute>
<xs:attribute name="src_ file" type="xs:string"
use="optional">
</xs:attribute>
<xs:attribute name="export" use="optional" default="input only">
<xs:annotation>
<xs:documentation>
Indicate export all setting items or input only
</xs:documentation>
</xs:annotation>
<xs:simpleType>
<xs:restriction base="xs:string">
<xs:enumeration value="all"></xs:enumeration>
<xs:enumeration value="input only"></xs:enumeration>
</xs:restriction>
</xs:simpleType>
</xs:attribute>
<xs:attributeGroup ref="lsccip:ipany.att"/>
</xs:complexType>
<!-- ip.interface-->
<xs:complexType name="portsType">
<xs:sequence>
<xs:element maxOccurs="unbounded" minOccurs="1" name="port"
type="1lsccip:portElementType" />
</xs:sequence>
<xs:attribute ref="xml:base" use="optional"/>
</xs:complexType>
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<!-- ip.interface-->

<xs:complexType name="generalType">

<xXs:sequence>

<xs:element maxOccurs="1"
type="xs:string" />
<xs:element maxOccurs="1"
type="xs:Name" />
<xs:element maxOccurs="1"
type="xs:string" />
<xs:element maxOccurs="1"
type="xs:string" />
<xs:element maxOccurs="1"
type="xs:string" />
<xs:element maxOccurs="1"
type="xs:string" />
<xs:element maxOccurs="1"
type="xs:string" />
<xs:element maxOccurs="1"
type="xs:string" />
<xs:element maxOccurs="1"

type="xs:boolean" />

<xs:element maxOccurs="1"

minOccurs="0" name="vendor"

minOccurs="0" name="library"

minOccurs="1" name="name"

minOccurs="0" name="display name"

minOccurs="1" name="version"

minOccurs="1" name="category"

minOccurs="0" name="keywords"

minOccurs="0" name="type"

minOccurs="0" name="instantiatedOnce"

minOccurs="1"

name="min radiant version" type="lsccip:twoFigureVersionType" />

<xs:element maxOccurs="1"

minOccurs="0"

name="max radiant version" type="lsccip:twoFigureVersionType" />
<xs:element maxOccurs="1" minOccurs="0" name="min esi version"

type="1sccip:twoFigureVersionType" />
<xs:element maxOccurs="1" minOccurs="0" name="max esi version"

type="1sccip:twoFigureVersionType" />

<xs:element maxOccurs="1"

minOccurs="1"

name="supported products" type="lsccip:supportedProductsType" />

<xs:element maxOccurs="1"

minOccurs="0"

name="supported platforms" type="lsccip:supportedPlatformsType" />

</xs:sequence>
</xs:complexType>

<xs:complexType name="supportedPlatformsType">

<Xs:sequence>

<xs:element maxOccurs="unbounded"

type="1sccip:supportedPlatformType" />

</xs:sequence>
</xs:complexType>

<xs:complexType name="supportedPlatformType">

<Xs:sequence>

minOccurs="1" name="supported platform"

<xs:element maxOccurs="unbounded" minOccurs="0" name="supported templates"
type="1sccip:supportedTemplatesType" />

</xs:sequence>

<xs:attribute name="name" type="xs:string"/>

</xs:complexType>

<xs:complexType name="supportedTemplatesType">

<Xs:sequence>
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<xs:element maxOccurs="unbounded" minOccurs="0" name="supported template"
type="1sccip:supportedTemplateType" /> B
</xs:sequence>
</xs:complexType>

<xs:complexType name="supportedTemplateType">
<xs:attribute name="processor" type="xs:string"/>
<xs:attribute name="family" type="xs:string"/>
<xs:attribute name="name" type="xs:string"/>
<xs:attribute name="version" type="xs:string" use="optional"/>
</xs:complexType>

<xs:complexType name="supportedProductsType">
<xs:sequence>
<xs:element maxOccurs="unbounded" minOccurs="1" name="supported family"
type="1sccip:supportedFamilyType" /> -
</xs:sequence>
</xs:complexType>

<xs:complexType name="supportedFamilyType">
<xs:sequence>
<xs:element maxOccurs="unbounded" minOccurs="0" name="supported device"
type="1sccip:supportedDeviceType" /> B
</xs:sequence>
<xs:attribute name="name" type="xs:string"/>
</xs:complexType>

<xs:complexType name="supportedDeviceType">
<xs:sequence>
<xs:element maxOccurs="unbounded" minOccurs="0"
name="supported speed grade" type="lsccip:supportedSpeedType" />
</xs:sequence>
<xs:attribute name="name" type="xs:string"/>
</xs:complexType>

<xs:complexType name="supportedSpeedType">
<xs:sequence>
<xs:element maxOccurs="unbounded" minOccurs="0" name="supported package"
type="1sccip:supportedPackageType" /> B
</xs:sequence>
<xs:attribute name="name" type="xs:string"/>
</xs:complexType>

<xs:complexType name="supportedPackageType">
<xs:attribute name="name" type="xs:string"/>
</xs:complexType>

<!-- ip.estimatedResources -->
<xs:complexType name="estimatedResourcesType">
<xs:annotation>
<xs:documentation>
IP estimated resources definition.
</xs:documentation>
</xs:annotation>
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<xs:sequence>
<xs:element name="estimatedResource" type="lsccip:estimatedResourceType"
minOccurs="1" maxOccurs="unbounded" />
</xs:sequence>
</xs:complexType>

<xs:complexType name="estimatedResourceType">
<xs:sequence>
<xs:element name="name" type="xs:string"/>
<xs:element name="number" type="xs:string"/>
</xs:sequence>
</xs:complexType>

<!-- ip -->
<xs:element name="ip">
<xs:complexType>
<xs:sequence>
<xs:element name="general" type="lsccip:generalType" />
<xs:element name="settings" type="lsccip:settingsType" />
<xs:element name="ports" type="lsccip:portsType" />
<xs:element name="outFileConfigs" type="lsccip:outFileConfigsType"
maxOccurs="1" minOccurs="0">
<xs:unique name="fileCfgKey">
<xs:selector xpath="lsccip:fileConfig"/>
<xs:field xpath="@name"/>
</xs:unique>
</xs:element>
<xs:element ref="lsccip:busInterfaces" minOccurs="0" />
<xs:element ref="lsccip:addressSpaces" minOccurs="0" />
<xs:element ref="lsccip:memoryMaps" minOccurs="0" />
<xs:element ref="lsccip:componentGenerators" minOccurs="0" />
<xs:element ref="lsccip:choices" minOccurs="0" />
<xs:element ref="lsccip:fileSets" minOccurs="0" />
<xs:element ref="lsccip:design" minOccurs="0"
maxOccurs="unbounded" />
<xs:element name="estimatedResources"
type="1lsccip:estimatedResourcesType" minOccurs="0" />
<xs:element ref="lsccip:parameters" minOccurs="0" />
</xs:sequence>
<xs:attribute name="version" type="lsccip:twoFigureVersionType"/>
<xs:attribute name="platform" type="xs:string" use="optional"/>
<xs:attribute name="platform version" type="lsccip:twoFigureVersionType"
use="optional"/>
</xs:complexType>
</xs:element>

</xs:schema>
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Technical Support Assistance

Submit a technical support case through www.latticesemi.com/techsupport.
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